Installation Guide for SAP S/4HANA 1709
Feature Package Stack 01
## Content

1. **Getting Started.** .......................................................... 5
2. **SAP S/4HANA System Landscape Information.** .................. 6
3. **Installation Documentation.** .......................................... 8
4. **Product Information.** ..................................................... 11
5. **Maintenance Planner.** ................................................... 15
6. **Installation Process.** ..................................................... 16
7. **Installation Follow-Up Activities.** .................................... 17
   7.1 Applying the Latest Kernel and Support Package Stacks. ............... 17
   7.2 Importing Data to SAP S/4HANA. ..................................... 18
       SAP S/4HANA Migration Cockpit. ..................................... 18
       SAP Data Services. ..................................................... 19
   7.3 System Configuration for SAP S/4HANA. ............................ 20
   7.4 User Assistance Settings. ............................................. 20
       Enable User Assistance for the Back-End System. .................. 20
       Enable Context-Sensitive User Assistance for SAP Fiori Launchpad. 22
   7.5 Follow-Up Activities for Advanced Variant Configuration. ............ 26
   7.6 Follow-Up Activities for Predictive Analytics Integrator. ............ 27
   7.7 Follow-Up Activities for Analytics. ................................... 27
   7.8 Installation of SAP Fiori. ............................................ 27
   7.9 Installation of the PI Adapters for Elster and Swift. .................. 28
   7.10 Creating RFC Destinations for liveCache Applications. .............. 28
   7.11 Follow Up Activities in Master Data Governance. ................... 30
   7.12 Follow-Up Activities for Environment, Health, and Safety. ........... 31
   7.13 Follow-Up Activities for Enterprise Portfolio and Project Management. 32
       Follow-Up Activities for SAP Portfolio and Project Management. ... 32
       Follow-Up Activities for Commercial Project Management. .......... 33
   7.14 Follow-Up Activities for Product Safety and Stewardship. ............ 42
       Follow-Up Activities for Product Compliance. ....................... 42
       Follow-Up Activities for Product Safety and Stewardship for Process Industries. 43
   7.15 Follow-Up Activities for Supplier and Category Management. .......... 43
   7.16 Follow-Up Activities for Human Resources (Compatibility Packs). ...... 44
       Integration in SAP S/4HANA. ........................................ 44
       Integration Scenarios. ................................................ 45
Conversion from SAP ERP to SAP S/4HANA ........................................... 58
Employee-Business Partner Synchronization. ......................................... 61
FAQ ........................................................................................................ 71
Related Notes. ..................................................................................... 71

7.17 Follow-Up Activities for SAP S/4HANA for Extended Procurement. ......................................... 72
    Integration in SAP S/4HANA. ............................................................ 72
    Integration Scenarios. .................................................................... 72

7.18 Follow-Up Activities for the SAP S/4HANA Financial Closing Cockpit. ................................. 74
    Setting Up the BI Content. .............................................................. 74

7.19 Follow-Up Activities for Agricultural Contract Management. ............................................... 77
    Integration with Oil & Gas and Commodity Management. .............. 77

7.20 Troubleshooting. ........................................................................... 78
## Document History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>January 31, 2018</td>
<td>First published version.</td>
</tr>
<tr>
<td>1.0</td>
<td>May 03, 2018</td>
<td>Minor corrections and update of section SAP S/4HANA Migration Cockpit [page 18].</td>
</tr>
<tr>
<td>1.0</td>
<td>July 04</td>
<td>Minor corrections.</td>
</tr>
</tbody>
</table>
1 Getting Started

This guide provides you with the following information about SAP S/4HANA:

- A system landscape and product overview
- A list of the tools and documentation you need for the installation
- Important follow-up activities you need to consider after the installation

**Note**

This guide cannot be used on its own, you need to use it together with the installation guides describing the installation of SAP Application Server Systems Based on SAP NetWeaver using the Software Provisioning Manager 1.0 tool.

You find these guides (as well as a link to the SPM tool) on the SAP Support Portal at [https://support.sap.com/sitoolset](https://support.sap.com/sitoolset) ➔ System Provisioning ➔ Installation Option ➔ Installation Guides - Application Server Systems ➔ SAP Application Server Systems Based on SAP NetWeaver.

These installation guides are sorted by database, technology (ABAP and Java), and SAP NetWeaver product release. For the installation of SAP S/4HANA, choose the SAP HANA Database guide for your operating system (UNIX, IBM, or Windows) and SAP NetWeaver 7.X-based.
There are various ways of deploying SAP S/4HANA in your new or already existing system landscape. This section describes some examples.

**Example: SAP S/4HANA New Installation**

A new installation of SAP S/4HANA needs to run on the SAP HANA database. It is recommended to use the SAP Solution Manager, which can run on any database. This very simple landscape can be enhanced with the SAP cloud solutions and SAP Business Suite products.

**Example: SAP S/4HANA in an SAP Business Suite Landscape**

It is possible to integrate SAP S/4HANA into an existing SAP Business Suite landscape by replacing the SAP ERP enhancement package product with SAP S/4HANA. When performing this conversion in your system landscape,
you need to do some adaptations, for example you need to convert some of your existing business processes to the simplified SAP S/4HANA processes. Some of the SAP Business Suite processes are no longer supported, some have been changed, and there are also new processes. How to convert your existing processes to the SAP S/4HANA processes is described in the Simplification Item Catalog.

3 Installation Documentation

SAP S/4HANA 1709 FPS01 Required Installation Documentation

<table>
<thead>
<tr>
<th>Documents</th>
<th>Comments and Links</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Installation Guide for SAP S/4HANA 1709 Feature Package Stack 01 (this guide)</em></td>
<td>This document contains information relevant for the installation of SAP S/4HANA, but it does not describe the process or the installation tool. They are described in the Software Provisioning Manager guides listed below. Always find the latest version of this guide at the SAP Help Portal at [<a href="http://help.sap.com/s4hana_op_1709_001">http://help.sap.com/s4hana_op_1709_001</a>] Product Documentation.</td>
</tr>
</tbody>
</table>

Installation guides describing the installation of SAP systems based on SAP NetWeaver 7.1 and higher using the Software Provisioning Manager 1.0 which is part of SL Toolset 1.0. Make sure that you always use the latest SP version of the tool and guides available on the SAP Support Portal at [http://help.sap.com/sltoolset]. These installation guides are sorted by database technology. For the installation of SAP S/4HANA, choose the SAP HANA Database guide for your operating system (UNIX, IBM, or Windows) in the ABAP and Java technology versions.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Select your database</td>
</tr>
<tr>
<td>Product Release</td>
<td>SAP NetWeaver 7.X-based</td>
</tr>
<tr>
<td>Operating System Platform</td>
<td>Select your OS</td>
</tr>
<tr>
<td>Technical Stack</td>
<td>ABAP and JAVA</td>
</tr>
</tbody>
</table>
You need the SAP HANA Server Installation and Update Guide for the installation of the following components:

- **SAP LiveCache on HANA**
  If you plan to use the SAP S/4HANA [Production Planning & Detailed Scheduling (PP/DS)](http://help.sap.com/hana_platform#ProductionPlanning) application, it is important that you install HANA integrated liveCache, which is the HANA component SAP LCA (also called LCAPPS- or LiveCache Applications plugin).

- **VCH AFL (SAP VCH AFL 1709.01)**
  See also SAP Note [1898497](https://Support.sap.com/).

### Note
For each SAP HANA revision, there exists one corresponding version of these SAP HANA system components.

You find this guide on the SAP Help Portal at [http://help.sap.com/hana_platform#InstallationAndUpgrade](http://help.sap.com/hana_platform#InstallationAndUpgrade). For information about how to install or update these components, see the section Managing SAP HANA System Components in the guide.

<table>
<thead>
<tr>
<th>Documents</th>
<th>Comments and Links</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SAP HANA Server Installation and Update Guide</strong></td>
<td>You need the SAP HANA Server Installation and Update Guide for the installation of the following components:</td>
</tr>
<tr>
<td>- SAP LiveCache on HANA</td>
<td>If you plan to use the SAP S/4HANA Production Planning &amp; Detailed Scheduling (PP/DS) application, it is important that you install HANA integrated liveCache, which is the HANA component SAP LCA (also called LCAPPS- or liveCache Applications plugin).</td>
</tr>
<tr>
<td>- VCH AFL (SAP VCH AFL 1709.01)</td>
<td>See also SAP Note <a href="https://Support.sap.com/">1898497</a>.</td>
</tr>
</tbody>
</table>

**UI Technology Guide for SAP S/4HANA**


<table>
<thead>
<tr>
<th>Documents</th>
<th>Comments and Links</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SAP S/4HANA 1709: Release Information Note</strong></td>
<td>SAP Note <a href="https://Support.sap.com/">2482453</a>.</td>
</tr>
<tr>
<td><strong>SAP S/4HANA 1709: Restriction Note</strong></td>
<td>SAP Note <a href="https://Support.sap.com/">2491467</a>.</td>
</tr>
<tr>
<td><strong>SAP FIORI for SAP S/4HANA 1709: Release Information Note</strong></td>
<td>SAP Note <a href="https://Support.sap.com/">2482461</a>.</td>
</tr>
<tr>
<td><strong>SAP S/4HANA Add-on Note</strong></td>
<td>SAP Note <a href="https://Support.sap.com/">2214409</a>.</td>
</tr>
</tbody>
</table>

**Additional Documentation**

<table>
<thead>
<tr>
<th>Documents</th>
<th>Comments and Links</th>
</tr>
</thead>
</table>

**Installation Guide for SAP S/4HANA 1709**

**Installation Documentation**
<table>
<thead>
<tr>
<th>Documents</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>System copy guides describing the system copy of SAP systems based on</td>
<td>You find these guides on the SAP Help Portal at <a href="https://support.sap.com/sitoolset">https://support.sap.com/sitoolset</a> System Provisioning</td>
</tr>
<tr>
<td>SAP NetWeaver using the Software Provisioning Manager 1.0 tool.</td>
<td>System Copy Option of Software Provisioning Manager Guide for Systems Based on SAP NetWeaver 7.1 and Higher</td>
</tr>
</tbody>
</table>
# 4 Product Information

This section gives an overview of the components of SAP S/4HANA 1709 FPS01.

### SAP S/4HANA Components

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP S/4HANA Server</td>
<td>Based on SAP NetWeaver 7.52 for SAP S/4HANA 1709; SAP S/4HANA back-end system</td>
</tr>
</tbody>
</table>
| SAP Predictive Integrator | ● PRED ANALYTICS APL 3 FOR HANA 2  
● UMML4HANA 1 |
| SAP HANA Rules Framework | HANA RULES FRAMEWORK 1.0 |
| SAP S/4HANA AFL | SAP VCH AFL 1709.01 and alternative SCV |
| SAP LiveCache on SAP HANA | SAP HANA LCAPPS 1.00 |
| SAP Optimizer | SAP SCM Optimizer 13.0 |
| Integration for Elster | ● Elster 2.1  
● NW 7.52 for S/4HANA 1709 - Advanced Adapter Engine Extnd  
● UTELSTER 730 |
| Integration for Swift | ● NW 7.52 for S/4HANA 1709 - Advanced Adapter Engine Extnd  
● SWIFT 622  
● UTSWIFT 730 |
| ESR Content | SAP S/4HANA 1709 ESR Content (XI CONTENT) |
| SAP EHS Expert Server | EH&S EXPERT 3.2 |
| SAP EHS WWI Server | EH&S WWI 3.2 |

### Note

SAP S/4HANA 1709 FPS01 is based on SAP NetWeaver 7.52; but Elster and Swift can run on SAP NetWeaver 7.3 EHP1 and higher releases.
## SAP NetWeaver 7.52 for SAP S/4HANA 1709 (SPS 01)

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Server ABAP</td>
<td>- SAP ABA 7.5C</td>
</tr>
<tr>
<td></td>
<td>- SAP BASIS 7.52</td>
</tr>
<tr>
<td></td>
<td>- SAP BW 7.52</td>
</tr>
<tr>
<td></td>
<td>- SAP HOST AGENT 7.21</td>
</tr>
<tr>
<td></td>
<td>- SAP IGS 7.53</td>
</tr>
<tr>
<td></td>
<td>- SAP IGS HELPER</td>
</tr>
<tr>
<td></td>
<td>- SAP KERNEL 7.53 64-BIT UNICODE</td>
</tr>
<tr>
<td></td>
<td>- SAP NW GATEWAY FOUNDATION 7.52</td>
</tr>
<tr>
<td></td>
<td>- ST-PI 740</td>
</tr>
<tr>
<td></td>
<td>- USER INTERFACE TECHNOLOGY 7.52</td>
</tr>
<tr>
<td>Basis Apps</td>
<td>- NW 7.52 FOR S/4HANA 1709 - Application Server ABAP</td>
</tr>
<tr>
<td></td>
<td>- UI FOR BASIS APPLICATIONS 300</td>
</tr>
<tr>
<td>Business Intelligence</td>
<td>- NW 7.52 FOR S/4HANA 1709 - Application Server ABAP</td>
</tr>
<tr>
<td></td>
<td>- SAP NW 740 BI CONT ADDON 7.57</td>
</tr>
<tr>
<td>BI Content Extension</td>
<td>- NW 7.52 FOR S/4HANA 1709 - Application Server ABAP</td>
</tr>
<tr>
<td></td>
<td>- BI CONT EXT FOR BI CONT 7.57</td>
</tr>
<tr>
<td>TMC Content</td>
<td>TMC CONTENT 01</td>
</tr>
<tr>
<td>SAP S/4HANA Java</td>
<td></td>
</tr>
<tr>
<td>Adobe Document Services</td>
<td>- ADOBE DOCUMENT SERVICES 7.50</td>
</tr>
<tr>
<td></td>
<td>- NW 7.52 FOR S/4HANA 1709 - Application Server ABAP</td>
</tr>
<tr>
<td>Enterprise Services Repository</td>
<td>- ESR 7.50</td>
</tr>
<tr>
<td></td>
<td>- NW 7.52 FOR S/4HANA 1709 - SAP S/4HANA Java</td>
</tr>
<tr>
<td></td>
<td>- PI GUI LIBRARY 7.50</td>
</tr>
<tr>
<td></td>
<td>- XI CONTENT SAP_BASIS 7.50</td>
</tr>
<tr>
<td>Advanced Adapter Engine Extnd</td>
<td></td>
</tr>
<tr>
<td>Content Server</td>
<td>SAP CONTENT SERVER 6.50</td>
</tr>
<tr>
<td>Frontend</td>
<td>- ADOBE LIFECYCLE DESIGNER 11.0</td>
</tr>
<tr>
<td></td>
<td>- SAP BUSINESS CLIENT 6.5</td>
</tr>
<tr>
<td></td>
<td>- SAP GUI FOR JAVA 7.50</td>
</tr>
<tr>
<td></td>
<td>- SAP GUI FOR WINDOWS 7.50 CORE</td>
</tr>
<tr>
<td></td>
<td>- SAP SCREENREADER EXTENSIONS</td>
</tr>
<tr>
<td>SAP Web Dispatcher</td>
<td>SAP WEB DISPATCHER 7.53</td>
</tr>
<tr>
<td>SAPUI5 Dev Toolkit: IDE Plugins</td>
<td>SAPUI5 TEAM PROV IDE 3.00</td>
</tr>
</tbody>
</table>
### SAP Fiori for SAP S/4HANA 1709 FPS01

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td>SAP Fiori UIs can be installed as addons to the SAP S/4HANA back end or, in a hub installation, on the SAP NetWeaver AS for ABAP 7.52 for SAP S/4HANA 1709 standalone front-end server.</td>
<td></td>
</tr>
<tr>
<td>UI for SAP S/4HANA</td>
<td>• UIAPFI70 500</td>
</tr>
<tr>
<td></td>
<td>• UIS4H0P1 300</td>
</tr>
<tr>
<td></td>
<td>• UIX01CA1 200</td>
</tr>
<tr>
<td>UI for Approve Requests</td>
<td>UIX01CA1 200</td>
</tr>
<tr>
<td>UI for HCM (Human Capital Management) (old)</td>
<td>• UIHR001 100</td>
</tr>
<tr>
<td></td>
<td>• UIX01CA1 200</td>
</tr>
<tr>
<td>UI for HCM (Fiori 2.0)</td>
<td>• UIHR002 100</td>
</tr>
<tr>
<td></td>
<td>• UIX01CA1 200</td>
</tr>
<tr>
<td>UI for MDG</td>
<td>UIMDG001 200</td>
</tr>
<tr>
<td>UI for MDG (Master Data Governance) (old)</td>
<td>UIMDC001 200</td>
</tr>
<tr>
<td>UI for TVR</td>
<td>• UITRV001 200</td>
</tr>
<tr>
<td></td>
<td>• UIX01CA1 200</td>
</tr>
<tr>
<td>UI for ILM (old)</td>
<td>UIILM001 100</td>
</tr>
</tbody>
</table>

SAP Multichannel Foundation for Utilities and Public Sector, UI add-on for SAP S/4HANA 1709

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCF UI FOR SAP S/4HANA 1709+</td>
<td>UIS4MCF 100</td>
</tr>
</tbody>
</table>
### Database for SAP S/4HANA Backend

<table>
<thead>
<tr>
<th>Database for SAP S/4HANA Backend</th>
<th>Comments</th>
</tr>
</thead>
</table>
| **SAP HANA (SAP HANA DATABASE 2.0)** | Used as database for SAP S/4HANA backend; can also be used by SAP Fiori for SAP S/4HANA in an embedded and in a hub deployment (see table below). When configuring your SAP S/4HANA installation package through Software Provisioning Manager (SWPM), you get a screen named *Configuration of SAP liveCache with SAP HANA*. Here, choose to install liveCache for SAP System.  
  - For SAP S/4HANA you can only choose the SAP HANA integrated liveCache.  
  - You need the liveCache installation only when at least one of your applications use it.  
  - Client 000 is not a production client. |

### Databases for SAP Fiori for SAP S/4HANA (Frontend)

<table>
<thead>
<tr>
<th>Databases for SAP Fiori for SAP S/4HANA Frontend</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SAP HANA (SAP HANA DATABASE 1.0 and SAP HANA DATABASE 2.0)</strong></td>
<td>The SAP Fiori frontend for SAP S/4HANA can run on SAP HANA, SAP MaxDB, and SAP ASE in a hub deployment, but the database for the SAP S/4HANA backend must be SAP HANA (see table above).</td>
</tr>
<tr>
<td><strong>SAP MaxDB (MAXDB 7.9 64-BIT)</strong></td>
<td>For more information about SAP Fiori for SAP S/4HANA in a hub deployment, see <em>Landscape Deployment Recommendations for SAP Fiori Front-End Server</em>.</td>
</tr>
<tr>
<td><strong>SAP Adaptive Server Enterprise (SAP ASE) (SAP ASE 16.0 FOR BUS. SUITE)</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Note**

Databases other than the ones mentioned in the tables above are **not supported** for SAP S/4HANA.
5 Maintenance Planner

We recommend that you use the Maintenance Planner to plan your installation. The Maintenance Planner creates a stack XML file with the support package stack information that you then hand over to the Software Provisioning Manager (the installer).

**Note**

The Maintenance Optimizer (MOPZ) cannot be used with SAP S/4HANA. It has been replaced by the Maintenance Planner.

6 Installation Process

The installation process for SAP S/4HANA and its components is described in the Software Provisioning tool guides referenced in the section Installation Documentation [page 8].
7 Installation Follow-Up Activities

**i Note**

We recommend to use the ABAP Task Manager for Lifecycle Management Automation for the initial configuration of SAP NetWeaver-based systems.


7.1 Applying the Latest Kernel and Support Package Stacks

If you are already on SAP S/4HANA 1709, you can do an update to SAP S/4HANA 1709 FPS01.

**i Note**

Support package stack (SPS) is equivalent to feature package stack (FPS). The term feature indicates that new features are delivered with the FPS, not just bug fixes as with support package stacks.

**⇒ Recommendation**

Although it is possible to do the update manually, we recommend that you do this using the Software Update Manager (SUM), as described in the guide [Software Update Manager (SUM) 2.0 <latest sp> found at](https://support.sap.com/sltoolset) ▶ Software Logistics Toolset ▶ System Maintenance.

If you do want to update the kernel manually, proceed as follows:

1. Log on as user `<SAP System ID>adm` to the hosts of the SAP system instances to be updated.
2. Download the latest kernel for your operating system and database platform as described in SAP Note [19466](https://support.sap.com/sltoolset).
3. Back up the kernel directory that is specified by the profile parameter `DIR_CT_RUN`.  
4. Extract the SAR files of the kernel support packages of the target support package level to a temporary directory using the SAPCAR tool.
5. Copy or move the extracted programs from the temporary directory to the local kernel directory.
6. Adjust the ownership and permissions of the kernel binaries by entering the following command sequence (Run the `saproot.sh` script that is located in the kernel directory):

```bash
su - root
cd <kernel_directory>
./saproot.sh <SAP system ID>
exit
```
7.2 Importing Data to SAP S/4HANA

The following sections explain possible ways of migrating data to SAP S/4HANA:

- SAP S/4HANA Migration Cockpit [page 18]
- SAP Data Services [page 19]

7.2.1 SAP S/4HANA Migration Cockpit

For the migration of legacy data to SAP S/4HANA, SAP provides the SAP S/4HANA migration cockpit. It helps you to transfer your master data and business data from SAP systems and non-SAP systems to SAP S/4HANA 1610 and 1709. The cockpit is available as part of SAP S/4HANA and is included in the SAP S/4HANA license.

Preconfigured SAP S/4HANA-Specific Content

For the data migration, the SAP S/4HANA migration cockpit uses predefined migration content, that is, standard migration objects such as customer, supplier or purchase order objects to identify and transfer the relevant data. These migration objects contain pre-defined mappings to support the migration.

There are two options for transferring data to SAP S/4HANA:

1. Template file upload
   For each migration object, the migration cockpit provides Microsoft Excel XML files that contain the necessary fields for the SAP S/4HANA target structure. You download the file for the migration object, fill it with the source data, upload it to the cockpit, and then migrate the data to the SAP S/4HANA target system.

2. Staging tables
   As of SAP S/4HANA 1709 FPS01, the data transfer option using staging tables is available in the migration cockpit. This option allows you to handle large data volumes more easily. You can fill in the staging tables either manually or by using your preferred tools (SAP or third-party tools). The migration cockpit reads the data from the staging tables and migrates them into the SAP S/4HANA target system. As a prerequisite for this option, you need a remote system that acts as the staging system, and this system must be running an SAP HANA database.

Integration of Custom Data

In addition, the SAP S/4HANA migration cockpit allows you to integrate your custom data into the migration using the migration object modeler. For example, you can adjust the predefined standard migration objects by adding fields to them. As of SAP S/4HANA 1610 FPS02, you can create your own custom-specific migration objects or SAP standard objects that have not yet been included in the scope of the migration cockpit.
Migration Objects

For a list of the available migration objects, see http://help.sap.com/s4hana_op_1709_001 and search for Migration Cockpit. Then navigate to SAP S/4HANA Migration Cockpit > Transfering Data to SAP S/4HANA Using Files > Working with Migration Objects > Available Migration Objects.

Required Roles

For direct access to the SAP S/4HANA migration cockpit, use transaction LTMC. To work with the migration cockpit, you need the role SAP_CA_DMC_MC_USER.

To access the migration object modeler, use transaction LTMOM. As prerequisite for using the modeler, you first need to create a migration project in the migration cockpit and assign the role SAP_CA_DMC_MC_DEVELOPER to the respective user.

Additional Information

For more information, see:

- SAP Note 2481235: SAP S/4HANA Migration Cockpit (on-premise) - restrictions and extensibility of pre-delivered migration objects

7.2.2 SAP Data Services

SAP provides SAP Data Services with Rapid Data Migration content to assist you with importing your data into your SAP S/4HANA system after installation.

For additional information, see:

- SAP Notes 2239701 and 2287723
- SAP Data Services at the SAP Help Portal http://help.sap.com/bods
- SAP Best Practice content for data migration: http://rapid.sap.com/bp/RDM_S4H_OP
7.3 System Configuration for SAP S/4HANA

After you have installed SAP S/4HANA, you have a number of options how to proceed with the system configuration:

1. You follow SAP Activate and SAP Best Practices to guide you through your system configuration.

   **Note**
   
   We strongly recommend that you use SAP Activate and SAP Best Practices as this will simplify both the initial implementation process and future updates of your software.

SAP Activate is the innovation adoption framework that helps you to implement your SAP S/4HANA system. It provides ready-to-run business and technology processes and guided configurations. For ordering information see SAP Note 2041140 for partners and SAP Note 2202234 for customers. For additional information about SAP Activate and SAP Best Practices, see:

   ○ [SAP S/4HANA Cookbook](https://wiki.scn.sap.com/wiki/x/HDC7Gg)

2. You use SAP Activate and SAP Best Practices as templates for your system configuration and make changes using the Implementation Guide (IMG). This allows you to adapt the SAP-delivered configuration settings to your specific requirements.

3. You use only the Implementation Guide (IMG) to configure your system.

   **Note**
   

7.4 User Assistance Settings

The following sections describe how to enable context-sensitive user assistance for SAP S/4HANA.

7.4.1 Enable User Assistance for the Back-End System

Enable Context-Sensitive User Assistance

You need to do these settings in the back-end system which you use to create your system configuration setting. After you have done the settings, you save them, create a transport for them and transport them to your productive system(s).
Proceed as follows:

2. Select the tab *PlainHtmlHttp*.
3. Choose *New Entries*.

You have to create new entries for both documentation and XML documentation areas. To create entries for the **documentation** area, enter the following values:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value to be entered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variant</td>
<td>Enter a name for the variant (any name).</td>
</tr>
<tr>
<td>Platform</td>
<td>Select the platform relevant for your implementation, for example, WN32.</td>
</tr>
<tr>
<td>Area</td>
<td>Select <strong>Documentation</strong>. This will display as <strong>IWBHELP</strong> in the table.</td>
</tr>
<tr>
<td>Server Names</td>
<td><a href="https://cp.hana.ondemand.com">https://cp.hana.ondemand.com</a></td>
</tr>
<tr>
<td>Path</td>
<td><a href="dps/d/ahp/1709%20001">dps/d/ahp/1709%20001</a></td>
</tr>
<tr>
<td>Language</td>
<td>Select the language you need.</td>
</tr>
</tbody>
</table>

To create entries for the **XML documentation** area, enter the following values:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value to be entered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variant</td>
<td>Enter a name for the variant (any name).</td>
</tr>
<tr>
<td>Platform</td>
<td>Select the platform relevant for your implementation, for example, WN32.</td>
</tr>
<tr>
<td>Area</td>
<td>Select <strong>XML Documentation</strong>. This will display as <strong>XML_DOCU</strong> in the table.</td>
</tr>
<tr>
<td>Server Names</td>
<td><a href="https://cp.hana.ondemand.com">https://cp.hana.ondemand.com</a></td>
</tr>
<tr>
<td>Path</td>
<td><a href="dps/d/ahp/1709%20001">dps/d/ahp/1709%20001</a></td>
</tr>
<tr>
<td>Language</td>
<td>Select the language you need.</td>
</tr>
</tbody>
</table>

4. Repeat step 3 for each relevant platform and language.
5. Select one entry as default per platform.
6. Save your changes and create a transport.
Enable Product-Specific User Assistance

After you have done the settings in transaction sr13 described above, you need to enable the product-specific User Assistance with the program rsiwbh04 in transaction se38:

1. Open transaction se38.
2. Enter the program name rsiwbh04 in the Program field and open the program.
3. Under Product-Specific SAP Library enter the ID 2c0e7c571fbeb576e10000000a4450e5 in the Structure/ DITA Map ID field.
   ○ Class must be XDP_STRUCT.
   ○ The radio button Change must be selected.
4. Run the program.

7.4.2 Enable Context-Sensitive User Assistance for SAP Fiori Launchpad

To make context-sensitive user assistance available in the SAP Fiori launchpad, you need to do the settings described in the following sections:

- Configure the SAP Web Dispatcher [page 22]
- Set Up the User Assistance Plugin [page 24]

7.4.2.1 Configure the SAP Web Dispatcher

Use

If you want to make context-sensitive user assistance available in the SAP Fiori launchpad, you must configure SAP Web Dispatcher.

Prerequisites

You have installed SAP Web Dispatcher 7.5 as the reverse proxy. For more information, go to http://help.sap.com/s4hana_op_1709_001, enter Operating SAP Web Dispatcher into the search bar, press Enter, open the search result with that title and navigate to the section Installing SAP Web Dispatcher.

Activities

1. Adjust the SAP Web Dispatcher profile file.
In the `sapwebdisp_pf.txt` file, add the following parameters:

- **For the User Assistance Content Platform**
  
  ```
  wdisp/system_<number> = SID=<SID1>, EXTSRV=https://cp.hana.ondemand.com:443, 
  SRCURL=/sap/dfa/help/, SRCSRV=*:*:, PROXY=<your proxy>:<your proxy port>, 
  STANDARD_COOKIE_FILTER=OFF
  ```

- **For the script server in your production system**
  
  ```
  wdisp/system_<number> = SID=<SID2>, EXTSRV=https://xray.hana.ondemand.com:443, 
  SRCURL=/resources/sap/dfa/help/, SRCSRV=*:*:, PROXY=<your proxy>:<your proxy port>, 
  STANDARD_COOKIE_FILTER=OFF
  ```

**Note**

- Make sure that the numbers following `wdisp/system_` are smaller than the numbers that you use for all your application server. The rules for the context-sensitive user assistance need to come before the rules for the application servers.
- Make sure that the SIDs are not the same as your system IDs.

2. **Activate the usage of the modification handler:**
   
   ```
   icm/HTTP/mod_0 = PREFIX=/, FILE=$(DIR_PROFILE)/redirect.txt
   ```
   
   For more information, go to [http://help.sap.com/s4hana_op_1709_001](http://help.sap.com/s4hana_op_1709_001), enter *SAP Web Dispatcher Parameter References* into the search bar, press *Enter*, open the search result with that title and navigate to the section `icm/HTTP/mod_<xx>`.

3. **Adjust the SAP Web Dispatcher redirect file.**

   In the `redirect.txt` file, add the following parameters:

   ```
   # User Assistance Content Platform - rewrite rule
   if %{SID} = <SID1>
   begin
   SetHeader HOST cp.hana.ondemand.com:443
   RegRewriteRawUrl ^/sap/dfa/help/(.*) /dps/$1
   end
   
   # Script Server - rewrite rule
   if %{SID} = <SID2>
   begin
   SetHeader HOST xray.hana.ondemand.com:443
   RegRewriteRawUrl ^/resources/sap/dfa/help/(.*) /xRayControls/resources/sap/dfa/help/$1
   end
   ```

   **Note**

   Make sure that the SIDs in the `redirect.txt` file are the same as in the `sapwebdisp_cf.txt` file.

4. **You can check if the content platform is working properly through the proxy connection by accessing:**

   ```
   https://<your server>:<your port>/sap/dfa/help/odata.svc/?$format=json
   ```

**Example**

If the content platform is connected correctly, you can see on your screen the following output, for example:

```json
{"d":{"EntitySets": ["Transport","DeliverableForReplication","Tile","Project","Deliverable","TransportHistory","TourIssue","ReplicationTourIssue","Hotspot","Product","Context"]}}
```
5. You can check if the help script server is working properly through the proxy connection by accessing: https://<yourserver>:<yourport>/resources/sap/dfa/help/sap/cfg/XrayBootstrapHelpConfig.json

Example

If the help script server is connected correctly, you can see on your screen the following output, for example:

```
{
    "description": "This configuration registers the Xray bootstrap plug-in",
    "modulePaths": {
        "sap.dfa.help": "/resources/sap/dfa/help/~201509221536-"
    },
    "bootstrapPlugins": {
        "BootstrapXrayPlugin": {
            "module": "sap.dfa.help.utils.adapters.fiori.BootstrapXrayHelpPlugin"
        }
    }
}
```

Result

You can access SAP Fiori launchpad with context-sensitive user assistance.

7.4.2.2 Set Up the User Assistance Plugin

To make context-sensitive user assistance available in the SAP Fiori Launchpad, you set up the user assistance plugin in the following way:

1. You create a catalog.
   For more information about creating catalogs, see the documentation on SAP Fiori Launchpad at the SAP Help Portal under http://help.sap.com/s4hana_op_1709_001 ➤ SAP NetWeaver for SAP S/4HANA ➤ View All ➤ Function-Oriented View ➤ UI Technologies in SAP NetWeaver ➤ SAP Fiori Launchpad ➤ Administration Guide ➤ Initial Setup of the Launchpad ➤

2. You create a role that references the catalog.
   For more information about creating roles for tile catalogs, see the documentation on SAP Fiori Launchpad at the SAP Help Portal under http://help.sap.com/s4hana_op_1709_001 ➤ SAP NetWeaver for SAP S/4HANA ➤ View All ➤ Function-Oriented View ➤ UI Technologies in SAP NetWeaver ➤ SAP Fiori Launchpad ➤ Administration Guide ➤ Initial Setup of the Launchpad ➤

3. You assign the role to every user that needs to access the context-sensitive user assistance.
4. In the catalog, you create a target mapping with the following values:

<table>
<thead>
<tr>
<th>Field Label</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Semantic Object</td>
<td>Shell</td>
</tr>
<tr>
<td>Action</td>
<td>plugin</td>
</tr>
<tr>
<td>Application Type</td>
<td>SAPUI5 Fiori App</td>
</tr>
<tr>
<td>Title</td>
<td>User Assistance Plugin</td>
</tr>
<tr>
<td>URL</td>
<td>/resources/sap/dfa/help/utils/adapters/fiori</td>
</tr>
<tr>
<td></td>
<td>This requires that the SAP Web Dispatcher</td>
</tr>
<tr>
<td></td>
<td>is set up accordingly so that this URL is</td>
</tr>
<tr>
<td></td>
<td>routed to the script server.</td>
</tr>
<tr>
<td>Component</td>
<td>sap.dfa.help.utils.adapters.fiori</td>
</tr>
<tr>
<td>Information</td>
<td>User Assistance Plugin, relevant for all</td>
</tr>
<tr>
<td></td>
<td>app users</td>
</tr>
<tr>
<td>Device Types</td>
<td>Select your required devices:</td>
</tr>
<tr>
<td></td>
<td>○ Desktop</td>
</tr>
<tr>
<td></td>
<td>○ Tablet</td>
</tr>
<tr>
<td></td>
<td>○ Phone</td>
</tr>
<tr>
<td>Parameters</td>
<td>Enter the following parameters in the table:</td>
</tr>
<tr>
<td></td>
<td>○ Name: product; Default Value: SAP_S4HANA_ON-PREMISE</td>
</tr>
<tr>
<td></td>
<td>○ Name: version; Default Value: 1709 001</td>
</tr>
<tr>
<td></td>
<td>○ Name: editor; Default Value: false</td>
</tr>
<tr>
<td>Optional parameters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>○ Name: buttonLocation; Default Value: head</td>
</tr>
<tr>
<td></td>
<td>You can decide where the user assistance</td>
</tr>
<tr>
<td></td>
<td>button should appear by entering one of</td>
</tr>
<tr>
<td></td>
<td>the following values:</td>
</tr>
<tr>
<td></td>
<td>head: The user assistance button</td>
</tr>
<tr>
<td></td>
<td>appears in the SAP Fiori header in the</td>
</tr>
<tr>
<td></td>
<td>top right corner.</td>
</tr>
<tr>
<td></td>
<td>me: The user assistance button appears</td>
</tr>
<tr>
<td></td>
<td>in the Me Area.</td>
</tr>
<tr>
<td></td>
<td>○ Name: showWhatsNew; Default Value: false</td>
</tr>
<tr>
<td></td>
<td>You can decide whether “What’s New”</td>
</tr>
<tr>
<td></td>
<td>information should be displayed on app</td>
</tr>
<tr>
<td></td>
<td>level, if available. (No: false / Yes: true).</td>
</tr>
</tbody>
</table>

After you have made these setting, the user assistance icon is available for the SAP Fiori Launchpad.
7.5  Follow-Up Activities for Advanced Variant Configuration

Integration of the Fiori UI into SAP GUI

You enable the integration of the Advanced Variant Configuration SAP Fiori UI in SAP GUI as described in the product assistance on the SAP Help Portal:


Steps 1 to 3 in the documentation describe how to enable OData calls for the Fiori UI. Step 4 describes the settings required for enabling SAP GUI transactions in the SAP Fiori Launchpad and also contains important information about whitelisting.


This documentation describes how to set up a connection between the back-end system with a front-end server. This is necessary for activating the integrated SAP Fiori UI.

- In addition, you have to activate the following OData services on the front-end server:
  - LO_VCHCLF
  - LO_VCHCLF_INTEGRATION_LEGACY_SRV

For information about how to activate services, see https://help.sap.com/viewer/p/FOIRI_IMPLEMENTATION Implementation ➤ SAP Fiori: App Implementation ➤ Implementation Tasks on Front-End Server ➤ Activating OData Services

Execute the report VCH_MASS_MAINTENANCE

You use this report for the initial preparation of your variant configuration data for SAP S/4HANA Advanced Variant Configuration. For information about how to use the report, see the system documentation in transaction SE38 or SE80, click on the Goto menu, and select Documentation.

Post-Installation Steps for VCH AFL

An Application Function Library (AFL) extends the SAP HANA Database with functions required for business applications - specifically, the VCH AFL (Variant Configuration on SAP HANA) extends the SAP HANA Database with functions to run SAP S/4HANA Advanced Variant Configuration. After you have installed VCH AFL (SAP VCH AFL 1709.01), you need to do some post-installation steps for the VCH AFL described in SAP Note 2527105.
7.6 Follow-Up Activities for Predictive Analytics Integrator

To enable the use of Predictive Analytics integrator, perform the following steps:

- Install SAP HANA Automated Predictive Library 3.3. For information, go to https://help.sap.com/viewer/product/apl/3.2.0.8/en-US
  SAP HANA Automated Predictive Library Reference Guide
  Getting Started with SAP HANA APL
  Installing SAP HANA APL

- Import the Predictive Analytics integrator Delivery Unit. For more information, go to https://help.sap.com/viewer/p/SAP_HANA_PLATFORM
  Development
  SAP HANA Developer Guide (How to develop applications for SAP HANA Extended Application Services classic model using the SAP HANA studio, including modeling data and analytic views, and building application logic)
  SAP HANA Application Lifecycle Management
  Maintaining Delivery Units
  Import a Delivery Unit

For information on configuring the roles required for Predictive Analytics integrator, go to https://help.sap.com/viewer/p/SAP_S4HANA_ON-PREMISE
  Product Assistance
  English
  Cross Components
  Analytics
  Predictive Models
  Configuration Information

7.7 Follow-Up Activities for Analytics

To enable the use of Analytics with SAP S/4HANA, you need to set up the Analytic Engine. For information how to do so, see SAP Note 2289865.

7.8 Installation of SAP Fiori

The SAP Fiori UIs need to be installed for SAP S/4HANA. You have the following two installation options for SAP Fiori:

- As add-on
  This is the embedded installation option, that is, the installation of Fiori UIs on the SAP S/4HANA 1709 FPS01 back-end system.

- As standalone server on a SAP NetWeaver system
  This is the hub installation option, with the SAP Fiori UIs installed on the SAP NetWeaver AS for ABAP 7.52 for SAP S/4HANA 1709 FPS01 front-end server.
For more information about the installation and configuration of SAP Fiori, see the SAP Help Portal at https://help.sap.com/fiori_implementation.

7.9 Installation of the PI Adapters for Elster and Swift

The Advanced Adapter Engine Extended (AEX) is required for the installation of the Process Integration Adapters for Elster and Swift. AEX is part of SAP NetWeaver 7.52 for SAP S/4HANA 1709 FPS01 as described in the section Product Information [page 11]. For more information about Elster and Swift, see also SAP Notes 1802839 and 1064419.

You have the following two options how to install the Elster/Swift adapters:

1 Installation from DVD

With this option, you copy the archives from the DVD location \S4HANA10JAVA\DATA_UNITS\S4_JAVA to the directory /usr/sap/trans/EPS/ and use the Software Update Manager (SUM) to deploy the files using the option Manually prepared directory.

For more information how to use the SUM tool, see SUM guides at https://support.sap.com/sltoolset Software Logistics Toolset 1.0 ➔ System Maintenance. Select the guide according to your operating systems and database.

2 Installation with Maintenance Planner

With this option, you use Maintenance Planner to generate a stack XML file with the Elster and Swift support package stack information that you then hand over to the Software Update Manager (SUM) tool.


7.10 Creating RFC Destinations for liveCache Applications

You use this procedure to use liveCache across clients, for example, to initialize liveCache correctly.

1. Create a user with the following authorizations in all production clients:
   - Cross-application AAAB authorization objects
     - Authorization object: S_TCODE Value: SE38
     - Authorization object: S_RFC Activity: 16
   - Name of RFC object to be protected: /SAPAPO/DM_LC_SYNC, SYST
   - Type of RFC object to be protected: FUGR
Basis development environment BC_C
- Authorization object: S_DEVELOP Value: 03, 16
- Authorization object: S_PROGRAM
- User action ABAP/4 program : *
- Authorization gr:ABAP/4 program : (no input necessary)

Basis administration BC_A
- Authorization object: 'S_BTCH_JOB'
- User action: 'RELE'

Note
Ensure that the user no longer has the initial password in any of the clients.

2. In each client, create a RFC destination by performing the following substeps:
   1. Start transaction SM59.
   2. Choose Create.
   3. Add a CLNT string and the client number (for example, "678") to your system ID (for example, "XYZ") to determine the connection name.

   Note
   This constitutes the connection name (for example, "XYZCLNT678"). You must adhere to this naming convention as ABAP does not recognize other names, for example, "XYZMAND678", and causes errors. If there is already a connection with the same destination but a different name, you must still create the connection as described.

4. Enter the connection name in RFC destination.
5. As a connection type, choose "3" (= SAP S/4HANA backend system destination or connection to the ABAP system).
6. Enter a description for the destination.
7. In the Logon section, enter the user credentials of the user created in this client in step 1.

   Note
   Ensure that the password is no longer initial, and do not select Current User.

8. Save the changes.

Verifying the Above Steps

To check that you have carried out all the steps correctly, choose Remote Login.

The system should display an SAP S/4HANA backend system window, but not an SAP S/4HANA backend system logon screen. If the system displays an SAP S/4HANA backend system logon screen, check if all steps above were performed correctly, you should check whether or not the user is actually available in this client (in particular). This test is not possible with an RFC destination with a CPIC user.

Note
You create the same user in each client only once. You must, however, ensure that the clients of the destination and user match. The user may also be a CPIC user. The authorization "Authorization object: S_TCODE Value:
7.11 Follow Up Activities in Master Data Governance

Gateway Buffering in Test Systems

To avoid very slow performance, the metadata cache and usage of shared memory for caching options need to be activated. In productive systems, metadata caching is active by default. However, if you are working in test systems you have to activate the Gateway metadata caching (buffering) manually. These settings have to be performed on the frontend system where the Gateway server is installed.

To manually activate these settings, in a test system, you do the following:

1. Go to the Gateway system with transaction /IWFND/MED_ACTIVATE, or in Customizing by the IMG path
   SAP NetWeaver ➤ SAP Gateway ➤ OData Channel ➤ Administration ➤ Cache Settings ➤ Metadata ➤ Activate or Deactivate Cache.
2. Select the **Activate Metadata Cache** check box
3. Select the **Use Shared Memory for Caching** check box
7.12 Follow-Up Activities for Environment, Health, and Safety

After the installation, you need to carry out the following activities for Environment, Health, and Safety:

- In transaction SICF, activate the following WebDynpro services below the node /default_host/sap/bc/webdynpro/sap/:
  - All EHFND* and EHHSS* services
  - POWL
  - IBO_WDA_INBOX
  - WDR_CHIP_PAGE

- Also activate the following services
  - NWBC runtime node on the path /default_host/sap/bc/nwbc.
  - SAPUI5 application handler on the path /default_host/sap/bc/ui5_ui5 and on the path /default_host/sap/public/bc/ui5_ui5.

- Copy the delivery Customizing from client 000 into your other clients.
- Make the relevant settings in the Customizing activities for Environment, Health, and Safety under Foundation for EHS and under Incident Management, under Health and Safety Management, or under Environment Management.
7.13 Follow-Up Activities for Enterprise Portfolio and Project Management

7.13.1 Follow-Up Activities for SAP Portfolio and Project Management

Navigation

To enable the navigation, carry out the following manual steps:


2. From the delivery client, copy the data from the Customizing tables mentioned below using transaction /n/RPM/CUST_COPY:
   - /RPM/DASH_PERS: Dashboard Customization
   - /RPM/DASH_ROLE: Dashboard Attributes Override Table
   - /RPM/INM_NAV_CTX: INM Navigation Context
   - /RPM/INM_NAV_CTX_W: INM Navigation Context Workcenter
   - /RPM/INM_NAV_INF_W: INM Navigation Information

3. Manually adjust and compare the Customizing data with the delivery client using transaction SCU0.

4. Initially all dashboard fields are displayed as standard fields. With this, it is not possible to navigate to the object windows. To activate the links to the object windows, select the Link checkbox in Customizing for SAP Portfolio and Project Management under Portfolio Management ➤ Global Customizing ➤ Global Field Settings ➤ Dashboard Settings ➤ Define Fields for Dashboards. You can also copy the Customizing for the dashboards by copying /RPM/DASHBOARD using transaction /n/RPM/CUST_COPY.

⚠️ Caution

This transaction copies the standard Customizing for all dashboards and invalidates all customer-specific Customizing for the dashboards. Object-type-specific copying is not supported by transaction /n/RPM/CUST_COPY.
7.13.2 Follow-Up Activities for Commercial Project Management

7.13.2.1 Overall Implementation Sequence

This section describes the implementation sequence for Project Workspace, Project Cost and Revenue Planning, and Project Issue and Change Management.

The Release Information Note (SAP Note 2507203) contains important information and references related to Commercial Project Management. Based on your business needs, you can choose one of the following component combinations as a deployment option:

<table>
<thead>
<tr>
<th>Deployment Option</th>
<th>Project Workspace</th>
<th>Project Cost and Revenue Planning</th>
<th>Project Issue and Change Management</th>
<th>SAP BusinessObjects Analysis for Microsoft Office (Analysis Office)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option 1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Option 2</td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Option 3</td>
<td>x</td>
<td></td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Option 4</td>
<td>x</td>
<td></td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

**Option 1**

Install Project Workspace, Project Cost and Revenue Planning, and Project Issue and Change Management with Analysis Office (AO):

1. **Activate the** /CPD/CA_CPD_PWS_1 **business function** (see transaction SFW5 ➤ Enterprise Business Functions ➤ /CPD/CA_CPD_PWS_1 ➤).

   **Note**
   
   The activation of the business function OPS_PS_CI_1 is a prerequisite for working with Project System (PS) projects.

2. **Activate the** /CPD/CA_CPD_PFP_1 **business function** (see transaction SFW5 ➤ Enterprise Business Functions ➤ /CPD/CA_CPD_PFP_1 ➤).

3. **Activate the** /PICM/CA_CPD_PICM_1 **business function** (see transaction SFW5 ➤ Enterprise Business Functions ➤ /PICM/CA_CPD_PICM_1 ➤).

4. Install NWBC for Desktop (optional).

5. Install Analysis Office (see SAP note 2188859).

6. Enable Planning Application Kit (PAK). PAK allows you to use the workbooks of SAP BusinessObjects Analysis, edition for Microsoft Office as part of the Commercial Project Management content.

**Procedure**

1. Get the latest information posted in SAP note 1637199.
2. In the back-end system, launch table/view maintenance (transaction SM30).
3. Enter RSPLS_HDB_ACT in the table/view field and choose Maintain.
4. Choose New Entries.
5. In the HANA Integratn. Active column, select Deep HANA Integration Active; and in the Functn. Active column, mark the checkbox.
7. Commercial Project Management uses the BW layer that is available in each NetWeaver stack.

**Caution**

Project Cost and Revenue Planning uses BW Integrated Planning (BW-IP), which uses real-time InfoCubes to capture data generated through input-ready queries and planning functions. Therefore, only a configuration of the local BI client is required (and not an additional BI system).

For setting up Project Cost and Revenue Planning, see SAP note 2363617.

8. You must activate the analytics content under info-areas /CPD/AVR and /PICM/AVR. For information about setting up Analytics, see SAP Note 1999149.

9. You must follow these steps to enable delivery customizing in the relevant clients:
   1. Go to transaction SFW_BROWSER
   2. Expand the business function /CPD/CA_CPD_PWS_1
   3. Double-click on switch /CPD/CA_CPD_SFWS_PWS_1 to implement BC set activation.
   4. Choose the **Activate Dependent BC Sets** button.
   5. In the dialog box, select **Activate Switch BC Sets** and choose Continue.
   6. In the next dialog box, select the following:
      1. Only Logon client for Cascading BC Sets
      2. Activate in logon client for Non-Cascading BC sets
      3. Activate for Cross-Client BC sets
      4. Mark the checkboxes to ignore previous activations and ignore table delivery class for a new installation
   7. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PWS_S4_1.
   8. Expand the business function /CPD/CA_CPD_PFP_1.
   9. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PFP_1.
   10. Expand the business function /PICM/CA_CPD_PICM_1.
   11. Repeat the BC set activation steps for the switch /PICM/CA_CPD_SFWS_PICM_1.

10. Check and activate SICF services as follows:
    1. Go to transaction SICF.
    2. Choose Execute.
    3. Go to | default host sap bc webdynpro |
    4. Ensure that all services under the cpd node are active.
    5. Ensure that all services under the picm node are active.

11. BRF+ framework is used within analytics and the processing of change requests in Project Issue and Change Management. Import the BRF+ customizing application as follows:
   - **Client 000**
     1. Run the report FDT_TRANS
     2. Provide the relevant customizing request
     3. Enter the object ID as 7C63E6507DA2A220E10000000A428544
     4. Enter the object ID as 386AA71741841EE59EFA4B491883514
     5. Enter the object ID as F0D5105146757029E10000000A42852B
     6. Select the **Transport Whole Application(s)** radio button
   - **Productive Client**
     1. Launch the transaction SCC1
2. Enter the source client as **000**
3. Provide the transport request in which you have transported the application (from client 000)
4. Mark the checkbox **Include Tasks in Requests**
5. Execute the transaction

### Option 2

Install Project Workspace and Project Cost and Revenue Planning with Analysis Office (AO):

1. Activate the */CPD/CA_CPD_PWS_1* business function (see transaction SFW5) »*Enterprise Business Functions* */CPD/CA_CPD_PWS_1*.

### Note

The activation of the business function */OPS_PS_CI_1* is a prerequisite for working with Project System (PS) projects.

2. Activate the */CPD/CA_CPD_PFP_1* business function (see transaction SFW5) »*Enterprise Business Functions* */CPD/CA_CPD_PFP_1*).

3. Install NWBC for Desktop (optional).
4. Install Analysis Office (see SAP note 2188859).
5. Enable **Planning Application Kit** (PAK). PAK allows you to use the workbooks of SAP BusinessObjects Analysis, edition for Microsoft Office as part of the Commercial Project Management content.

### Procedure

1. Get the latest information posted in SAP note 1637199.
2. In the back-end system, launch table/view maintenance (transaction SM30).
3. Enter */RSPLS_HDB_ACT* in the table/view field and choose **Maintain**.
4. Choose **New Entries**.
5. In the **HANA Integrtn. Active** column, select **Deep HANA Integration Active**; and in the **Functn. Active** column, mark the checkbox.

6. Commercial Project Management uses the BW layer that is available in each NetWeaver stack.

### Caution

Project Cost and Revenue Planning uses BW Integrated Planning (BW-IP), which uses real-time InfoCubes to capture data generated through input-ready queries and planning functions. Therefore, only a configuration of the local BI client is required (and not an additional BI system).

For setting up Project Cost and Revenue Planning, see SAP note 2363617.
7. You must activate the analytics content under info-area */CPD/AVR*. For information about setting up Analytics, see SAP Note 1999149.
8. You must follow these steps to enable delivery customizing in the relevant clients:
   1. Go to transaction */SFW_BROWSER*
   2. Expand the business function */CPD/CA_CPD_PWS_1*
   3. Double-click on switch */CPD/CA_CPD_SFWS_PWS_1* to implement BC set activation.
   4. Choose the **Activate Dependent BC Sets** button.
   5. In the dialog box, select **Activate Switch BC Sets** and choose **Continue**.
   6. In the next dialog box, select the following:
      1. **Only Logon client for Cascading BC Sets**
2. **Activate in logon client for Non-Cascading BC sets**
3. **Activate for Cross-Client BC sets**
4. Mark the checkboxes to ignore previous activations and ignore table delivery class for a new installation
7. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PWS_S4_1.
8. Expand the business function /CPD/CA_CPD_PFP_1.
9. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PFP_1.
9. Check and activate SICF services as follows:
   1. Go to transaction SICF.
   2. Choose **Execute**.
   3. Go to default host sap bc webdynpro.
   4. Ensure that all services under the cpd node are active.
10. BRF+ framework is used within analytics. Import the BRF+ customizing application as follows:
    - **Client 000**
      1. Run the report FDT_TRANS.
      2. Provide the relevant customizing request
      3. Enter the object ID as 7C63E6507DA2A220E10000000A428544
      4. Enter the object ID as 38EAA71741841EE59EFAD4B491883514
      5. Select the **Transport Whole Application(s)** radio button
    - **Productive Client**
      1. Launch the transaction SCC1.
      2. Enter the source client as 000.
      3. Provide the transport request in which you have transported the application (from client 000).
      4. Mark the checkbox **Include Tasks in Requests**.
      5. Execute the transaction.

**Option 3**

Install Project Workspace and Project Issue and Change Management with Analysis Office (AO):

1. Activate the /CPD/CA_CPD_PWS_1 business function (see transaction SFW5) [Enterprise Business Functions /CPD/CA_CPD_PWS_1]

   **Note**
   
   The activation of the business function OPS_PS_CI_1 is a prerequisite for working with Project System (PS) projects.

2. Activate the /PIM/CA_CPD_PICM_1 business function (see transaction SFW5) [Enterprise Business Functions /PIM/CA_CPD_PICM_1]
3. Install NWBC for Desktop (optional).
4. Install Analysis Office (see SAP note 2188859).
5. You must activate the analytics content under info-areas /CPD/AVR and /PIM/AVR. For information about setting up Analytics, see SAP Note 1999149.
6. You must follow these steps to enable delivery customizing in the relevant clients:
   1. Go to transaction SFW_BROWSER.
   2. Expand the business function /CPD/CA_CPD_PWS_1.
3. Double-click on switch /CPD/CA_CPD_SFWS_PWS_1 to implement BC set activation.
4. Choose the Activate Dependent BC Sets button.
5. In the dialog box, select Activate Switch BC Sets and choose Continue.
6. In the next dialog box, select the following:
   1. Only Logon client for Cascading BC Sets
   2. Activate in logon client for Non-Cascading BC sets
   3. Activate for Cross-Client BC sets
   4. Mark the checkboxes to ignore previous activations and ignore table delivery class for a new installation
7. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PWS_S4_1.
8. Expand the business function /PICM/CA_CPD_PICM_1.
7. Check and activate SICF services as follows:
   1. Go to transaction SICF.
   2. Choose Execute.
   3. Go to \default host \sap \bc \webdynpro\.
   4. Ensure that all services under the cpd node are active.
   5. Ensure that all services under the picm node are active.
8. BRF+ framework is used within analytics and the processing of change requests in Project Issue and Change Management. Import the BRF+ customizing application as follows:
   ○ Client 000
     1. Run the report FDT_TRANS
     2. Provide the relevant customizing request
     3. Enter the object ID as 7C63E6507DA2A220E10000000A428544
     4. Enter the object ID as 38EAA71741841EE59EFAD4B491883514
     5. Enter the object ID as F0D5105146757029E10000000A42852B
     6. Select the Transport Whole Application(s) radio button
   ○ Productive Client
     1. Launch the transaction SCC1
     2. Enter the source client as 000
     3. Provide the transport request in which you have transported the application (from client 000)
     4. Mark the checkbox Include Tasks in Requests
     5. Execute the transaction

Option 4

Install Project Workspace with Analysis Office (AO):

1. Activate the /CPD/CA_CPD_PWS_1 business function (see transaction SFW5) → Enterprise Business Functions
 → /CPD/CA_CPD_PWS_1 →.

   Note
   The activation of the business function OPS_PS_CI_1 is a prerequisite for working with Project System (PS) projects.

2. Install NWBC for Desktop (optional).
3. Install Analysis Office (see SAP note 2188859).
4. You must activate the analytics content under the info-area/CPD/AVR. For information about setting up Analytics, see SAP Note 1999149.
5. You must follow these steps to enable delivery customizing in the relevant clients:
   1. Go to transaction SFW_BROWSER
   2. Expand the business function /CPD/CA_CPD_PWS_1
   3. Double-click on switch /CPD/CA_CPD_SFWS_PWS_1 to implement BC set activation.
   4. Choose the Activate Dependent BC Sets button.
   5. In the dialog box, select Activate Switch BC Sets and choose Continue.
6. In the next dialog box, select the following:
   1. Only Logon client for Cascading BC Sets
   2. Activate in logon client for Non-Cascading BC sets
   3. Activate for Cross-Client BC sets
   4. Mark the checkboxes to ignore previous activations and ignore table delivery class for a new installation
7. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PWS_S4_1.
6. Check and activate SICF services as follows:
   1. Go to transaction SICF.
   2. Choose Execute.
   3. Go to default host sap bc webdynpro
   4. Ensure that all services under the cpd node are active.
7. BRF+ framework is used within analytics. Import the BRF+ customizing application as follows:
   - Client 000
     1. Run the report FDT_TRANS
     2. Provide the relevant customizing request
     3. Enter the object ID as 7C63E6507DA2A220E1000000A428544
     4. Enter the object ID as 38EAA71741841EE59EFAD4B491883514
     5. Select the Transport Whole Application(s) radio button
   - Productive Client
     1. Launch the transaction SCC1
     2. Enter the source client as 000
     3. Provide the transport request in which you have transported the application (from client 000)
     4. Mark the checkbox Include Tasks in Requests
     5. Execute the transaction

7.13.2.2 Settings for Project Workspace

Schema Mapping
For the HANA content of Commercial Project Management, you must map the SAP_ECC schema to the SAP <SID> schema.

Configuration of Display Options for Analytical Reports
Analytical UIBBs are used in Project Workspace to display reports such as Progress Analysis, Work in Progress, and Project Cost Status. By default, these reports are displayed in a SAP List Viewer (ALV) table. However, you can
also choose to view these reports as a graphic, or a table and graphic, or using Crystal Reports. To enable additional options for displaying reports, it is necessary to make the following Customizing settings:

To configure options for Graphic and Table and Graphic displays, follow these steps:

1. In Customizing for SAP NetWeaver, choose UI Technologies > SAP List Viewer (ALV) > Maintain Web Dynpro ABAP-Specific Settings.
2. Mark the Java Server Available checkbox.

   **Note**
   
   The display options are available in the frontend only if you also have enabled a Java server.

To configure options for Crystal Reports, follow these steps:

1. In Customizing for SAP NetWeaver, choose UI Technologies > SAP List Viewer (ALV) > Maintain SAP GUI-Specific Settings.
2. Mark the Allow Crystal Reports checkbox.

   **Note**
   
   ○ Commercial Project Management does not deliver any Crystal Report template for viewing reports.
   
   ○ Crystal reporting requires a special viewer in the frontend. This setting is only meaningful if this viewer has been installed. For more information, see SAP note 1353044.

**Set-Up for Launching Native Transactions in Project Workspace**

To launch native SAP transactions using the launchpad in Project Workspace, you must activate the MIME Repository service in the following way:

2. On the Maintain Services screen, select the hierarchy type Service and choose Execute.
3. In the Virtual Hosts / Services hierarchy, navigate to the MIME Repository service by choosing default_host > sap > public > bc > its > mimes.
4. Right-click and choose Activate Service.

**Definition of RFC Destinations for Charts**

The Fiori-themed analytics content of Commercial Project Management uses charts based on WebDynpro ABAP technology. To connect the IGS (Internet Graphics Server) to the SAP system, you have to create an RFC destination in the SAP system. For more information, see SAP note 454042.

**Activation of Relevant OData Services**

In Commercial Project Management, the following OData service must be activated:

CPD_MASTERPROJECT_OVERVIEW_SRV

**Installation and Upgrade of BW**

For information about the new and changed objects in this release, see SAP note 2526289.

**Enabling Enterprise Search**
In Commercial Project Management, the following search connectors must be set up:

- **Commercial Project**
  - Model Name: MASTERPROJECT_H
  - Connector Name: Commercial Project

- **Financial Plan**
  - Model Name: FINANCIALPLAN_H
  - Connector Name: Financial Plan

- **Change Request**
  - Model Name: CHANGEREQUEST_H
  - Connector Name: Change Request (Commercial Project)

- **Issue**
  - ISSUECHANGEREQ_H
  - Connector Name: Issue (Commercial Project)

The connector ID is generated automatically when the connector is created and the name of the connector can be edited. For more information, see SAP note 2382734.

**Role for Adding Fiori Apps in the Fiori Launchpad**

To add the Fiori apps of Commercial Project Management in the Fiori launchpad, the following role is required: SAP_BR_PROJECTMGR_COMMPRJ (Project Manager (CPM)).

**Set-Up for Linking Commercial Projects to CRM Opportunities**

To be able to link commercial projects to CRM opportunities, you must provide the HTTP connection to the CRM system (by defining the RFC destination (CPD_CRM) (connection type H)).

**Predefinition of Project Workspace Views**

For the predefinition of Project Workspace views for the personalization for end users, see SAP note 2011052.

### 7.13.2.3 Settings for Project Cost and Revenue Planning

**Schema Mapping**

For the HANA content of Commercial Project Management, you must map the SAP_ECC schema to the SAP <SID> schema.

**Set-Up of the Planning Group**

After installing the latest SP of SAP BusinessObjects Analysis, edition for Microsoft Office, follow these steps to activate the default planning options in workbooks:

1. Launch a planning workbook and navigate to File > Commercial Project > Settings.
2. In the Settings dialog box, choose the Advanced tab, select Show Planning Group.
3. Close and relaunch the planning workbook.

**Set-Up of SAP Multiresource Scheduling (MRS)**

Project Cost and Revenue Planning allows you to update staffing information in SAP Multiresource Scheduling. For more information about the compatibility of Commercial Project Management with SAP Multiresource Scheduling, see SAP Note 2363617.
Enhancing Workbooks for SAP BusinessObjects Analysis, edition for Microsoft Office

The delivered workbooks contain input-ready queries and planning objects, launched in a Microsoft Excel-based frontend for planning. We recommend that you use the delivered workbooks as templates and create your own workbooks to suit individual requirements. To know more about creating planning workbooks, see the relevant guides in https://help.sap.com/viewer/p/SAP_BUSINESSOBJECTS_ANALYSIS_OFFICE. We also recommend that you use the delivered input-ready queries as templates and create your own queries to suit your requirements.

Disabling the Intelligent Double-Click Function in SAP BusinessObjects Analysis, edition for Microsoft Office

Note

This setting is available only in SAP BusinessObjects Analysis, edition for Microsoft Office 1.4 SP02 and above.

When you double-click a cell, the intelligent double-click function (if enabled) automatically executes the first command in the context menu of the cell.

To disable the intelligent double-click function, do the following:

1. Launch Registry Editor. To know more about maintaining registry settings for SAP BusinessObjects Analysis, edition for Microsoft Office, see the relevant guides in https://help.sap.com/viewer/p/SAP_BUSINESSOBJECTS_ANALYSIS_OFFICE.
2. Depending on the type of installation, do one of the following:
   ○ If you are using a 32-bit operating system, locate the AdvancedAnalysis folder either under HKEY_CURRENT_USER\Software\SAP or HKEY_LOCAL_MACHINE\Software\SAP.
   ○ If you are using a 64-bit operating system, locate the Wow6432Node either under HKEY_CURRENT_USER\Software\SAP or HKEY_LOCAL_MACHINE\Software\SAP.
3. In the identified path, create nested keys to form the path *\Software\SAP\AdvancedAnalysis\Settings \ExcelGrid.
4. Under ExcelGrid, create the string EnableDoubleClick, and enter the value False.

Installation and Upgrade of BW

For information about the new and changed objects in this release, see SAP note 2522216.

Enhancing HANA Views to Add New Resources

For more information about enhancing HANA views to add new resources, see SAP note 2560000.

Data Consistency of Forecasting Method Descriptions During Upgrade

If you upgrade to Commercial Project Management 1709 onwards from the lower add-on releases SAP Commercial Project Management for S/4HANA 2.0 SP01 and SP02, you must execute the following report to ensure data consistency of forecasting method descriptions: /CPD/PFP_FORECAST_DATA_TRANS.

Clean-Up of Invalid FBI Structures

To clean up invalid FPM BOPF Integration (FBI) structures, you must run the /BOFU/R_FBI_VIEW_CLEANUP_DDIC report.

1. In transaction SE38, run /BOFU/R_FBI_VIEW_CLEANUP_DDIC.
2. In the selection screen, remove the checks in the following checkboxes:
   ○ Inactive Only
   ○ Deleted Objects Only
   ○ Test Mode
3. Choose Execute
4. The system lists inconsistent objects (from the following list). Select the objects that are listed by the system.
   - Business Object
     - /BOBF/ATTACHMENT_FOLDER
   - FBI View
     - /CPD/PWS_MP_SEXT
     - /CPD/PWS_MP_LIST
     - /BOFU/VIEW_ATF_DOC
     - /BOFU/VIEW_ATF
     - /CPD/WDC_PFP_HEADER_TEXT_FBIVIEW
     - /CPD/WDC_PFP_HEADER_FBIVIEW
     - /CPD/WDC_PFP_VERSION_FBIVIEW
     - /CPD/WDC_PFP_STRUCTURE_FBI_VIEW
     - /CPD/PWS_MP_PROJ_MEMBER
     - /CPD/PWS_PM
     - /CPD/PWS_TEAM_ROLES
     - /CPD/PFP_DETAIL_MAPPING_FBIVIEW

5. Choose Cleanup.

7.14 Follow-Up Activities for Product Safety and Stewardship

7.14.1 Follow-Up Activities for Product Compliance

For successful installation, always check the release information note 2278589 for the most current implementation details.

After the installation, carry out the following activities for Product Compliance for Discrete Industries:

- Verify and activate the following BC sets depending on the processes you need.
  For the process Managing Product Compliance:
    - EHPRC_SPECIAL Critical PRC Customizing from other components
    - EHPRC_BASIC Customizing for Product and REACH Compliance
    - EHPRC_DI_PRODUCT_COMPLIANCE Managing Product Compliance
  For the process Managing IMDS Compliance:
    - EHPRC_SPECIAL Critical PRC Customizing from other components
    - EHPRC_BASIC Customizing for Product and REACH Compliance
    - EHPRC_DI_IMDS_COMP Managing IMDS Compliance
  For both above mentioned processes:
    - EHPRC_SPECIAL Critical PRC Customizing from other components
    - EHPRC_BASIC Customizing for Product and REACH Compliance
    - EHPRC_DI Customizing for Product Compliance

- Verify and carry out all Customizing steps under SAP Customizing Implementation Guide Product Safety and Stewardship Product Compliance for Discrete Industries.
In transaction SICF, activate the following WebDynpro services below the node /default_host/sap/bc/webdynpro/sap/:
  ○ All EHFND* and EHPRC* services
  ○ POWL
  ○ IBO_WDA_INBOX
  ○ WDR_CHIP_PAGE

Also activate the following services:
  ○ NWBC runtime node on the path /default_host/sap/bc/nwbc.
  ○ SAPUI5 application handler on the path /default_host/sap/bc/ui5_ui5.

7.14.2 Follow-Up Activities for Product Safety and Stewardship for Process Industries

For successful installation, always check the release information note 2278589 for the most current implementation details.

After the installation, you need to carry out follow-up activities as described in the following SAP Notes:

- For information regarding installation instructions for Windows Wordprocessor Integration (WWI) and Expert / Open Content Connector (OCC), see SAP Note 568302.
- For information regarding installation instructions for the WWI server, see SAP Note 1394553.

7.15 Follow-Up Activities for Supplier and Category Management

After the installation, you need to carry out the following activities for Supplier and Category Management:

Delivery Customizing

You have to copy the delivery Customizing for Supplier and Category Management from client 000 to your relevant clients. You can run transaction Customizing Cross-System Viewer (SCU0) to compare Customizing contents in the 000 client and in the client in your system. For Supplier and Category Management, the following application components are relevant:

- SLC-EVL, SLC-ACT, SLC-CAT for Supplier and Category Management Customizing
- BC-SRV-NUM for number range intervals required for purchasing categories, activities, tasks, and for the objects used in Supplier Evaluation
- CA-GTF-SGF for Web Dynpro launchpad and OBN Customizing
- CA-GTF-SGF-POW for POWL Customizing
- BC-SEC-AUT-PFC for PFCG role Customizing
In addition, you must copy alert texts with text ID 'ALRT' and text names EVAL_REMINDER* and TASK* to the productive client. For more information, see SAP Note 601619.

Important SAP Notes

Define the system characteristic as described in SAP Note 2224695.

Activate Internet Communication Framework (ICF) Services

For information about the ICF services that you have to activate for Supplier and Category Management, see the configuration information for Supplier and Category Management. This documentation is included in the product assistance for SAP S/4HANA that is available on SAP Help Portal at http://help.sap.com/s4hana_op_1709_001.

Note

This documentation also contains further information about the implementation of Supplier and Category Management, such as jobs that must be scheduled and roles that need to be assigned.

7.16 Follow-Up Activities for Human Resources (Compatibility Packs)

7.16.1 Integration in SAP S/4HANA

Introduction

The recommended HCM solution for SAP S/4HANA is the SAP SuccessFactors HCM Suite. You can use the existing integration based on HANA Cloud Integration (HCI) to connect SAP SuccessFactors to the SAP S/4HANA system.

Note

No integration is required if the SAP S/4HANA system is used to store the data. This information is only relevant if you want to replicate data from your HR master system to the SAP S/4HANA system.
To transition into SAP S/4HANA system, it is important that at least the basic employee master data related infotypes (that is, infotypes 0,1,2,3,6,7,9,17, 32, 105, 315) are moved into the PA table and then this data is synchronized with BP in SAP S/4HANA system. Currently, the following transition options are available:

**Transition Options in SAP S/4HANA**

This document is only relevant if you are using integration options for SAP S/4HANA, that is, options 1, 3 and 4.

1. The following integration option is available for new customers:
   - If you are a new SAP HR or SAP S/4HANA (without a legacy SAP HCM system) customer, then you can implement SAP SuccessFactors and connect EC with SAP S/4HANA (Option 1 from the diagram)

2. The following integration options are available for existing customers.
   - If you are an SAP S/4HANA customer also using SAP ERP HCM and are not able to make the move to SAP SuccessFactors in the near term, you can continue to use SAP ERP HCM. You have 2 options:
     - Running SAP ERP HCM on a separate instance, integrated via ALE with SAP S/4HANA (Option 3 in diagram)
     - Running SAP ERP HCM on same instance with SAP S/4HANA (co-deployed) (Option 4 in diagram)
   - This integration helps minimize disruption in your HR processes during the SAP S/4HANA migration and enables the ability to migrate your HR processes to SAP SuccessFactors whenever you are ready.

### 7.16.2 Integration Scenarios

#### 7.16.2.1 Implementing SAP SuccessFactors

You can use this prepackaged integration to replicate employee master data and organizational data from SAP SuccessFactor Employee Central to the SAP S/4HANA system and cost center data from SAP S/4HANA to SAP SuccessFactor Employee Central, if you are using SAP SuccessFactors Employee Central as your HR master data system.
Based on your business requirements, you can:

- Replicate the employee mini master (basic infotypes) for using employee data in processes that are not HR specific.
- Replicate the employee global infotypes for using employee data in HR specific processes such as payroll.

**Prerequisites**

- In SAP S/4HANA system there has to be the Integration Add-On software component PA_SE_IN installed which does the inbound processing of the receiving Employee and Organizational data from SAP SuccessFactors via HCI.
- You need to install the following notes before you start replicating employee master data and organizational data:
  - 2539457: Business Person is created in Person category during Vendor creation or conversion when CVI is active.
  - 2542175: Employee Business Person is reused during Vendor creation or conversion when CVI is active.
  - 2517507: Reference Vendor data, company code, and bank account is created based on HR master data.
  - 2568251: Deleting the invalid business partner assignments.

**Steps for Execution**

**Implementing HR Mini Master Data**

You can replicate the basic PA infotypes and exclude the payroll infotypes from the integration. In this case, you can filter out the payroll specific infotypes during configuration and can skip the payroll related steps from the integration document.

For more information regarding the integration using HR mini master, download the documents from the Employee Integration: S/4HANA on-premise with Employee Central (1HW): Employee Integration: S/4HANA on-premise with Employee Central (1HW). Download the documents listed under Configuration:

- SuccessFactors: Integration of Employee Central and SAP S/4HANA (CSP)
- Integration of Employee Central to SAP S/4HANA(Employee, Org Data) with HCI (DSN)
- Integration of SAP S/4HANA to Employee Central (Cost Center Data) with HCI (DSI)

**Full Implementation**

If you want to replicate employee data to use the full scope of integration, (for example, payroll) you can refer to the following documents for detailed information:

- Employee data replication
  - Refer to the SAP help portal under Enterprise Management » SAP S/4HANA » SAP S/4HANA, on-premise edition » Additional Information » Integration Information » Replicating Employee Master Data from Employee Central to SAP S/4HANA Using SAP HANA Cloud Integration as the Middleware

- Organizational data replication
Refer to the SAP help portal under ➤ Enterprise Management ➤ SAP S/4HANA ➤ SAP S/4HANA, on-premise edition ➤ Additional Information ➤ Integration Information ➤ Replicating Organizational Data from Employee Central to SAP S/4HANA HR Using SAP HANA Cloud Integration as the Middleware ➤

- Cost center data replication

Refer to the SAP help portal under ➤ Enterprise Management ➤ SAP S/4HANA ➤ SAP S/4HANA, on-premise edition ➤ Additional Information ➤ Integration Information ➤ Replicating Cost Centers from SAP S/4HANA to Employee Central Using SAP HANA Cloud Integration as the Middleware ➤

### Employee-Business Partner Synchronization

Execute the employee synchronization after employee replication. For more details, refer to section Employee-Business Partner Synchronization [page 61].

### Change in the customizing

Set the following switch in the table T77S0: Set HRALX PBPON to OFF: Integration Employee or BP Activated.

**Note**

From 1709 SPS1 or after applying note 2535438 and note 2549563 in 1709, set HRALX HRAC to ‘X’ and HRALX PBPON to ‘ON’ to synchronize Employee information.

### Notes

- The cost center and company code are owned by SAP S/4HANA Finance. The cost centers defined in financials need to replicate into SAP SuccessFactors Employee Central to enable the assignment of employee to the Cost Center, for example, during the Hiring Process. This integration is supported through HCI Middleware iFlow.
- Company Codes are not replicated and have to be manually created in SAP SuccessFactors Employee Central (SFSF EC) because the definition of Companies in SFSF EC requires some additional information.
- SAP SuccessFactors Employee Central is responsible for the employee administration including the organizational assignment of employees to a Cost Center. This employment information is replicated into SAP S/4HANA via HCI.
- The Inbound processing within SAP S/4HANA maps existing Users with the corresponding Employee, Business Partner, and Employment.
7.16.2.2 Running SAP ERP HCM on a Separate Instance, Integrated via ALE with SAP S/4HANA

The purpose of this section is to enable the integration of employee data in the SAP S/4HANA system for running the employee-related processes in SAP S/4HANA. The HR master system is the SAP ERP HCM system, which is the source of the employee data.

For this integration, the Application Link Enabling (ALE) from the SAP ERP HCM system is reused and no specific changes required for SAP S/4HANA. This section describes the steps involved in ALE configuration.

Prerequisite

The Application Link Enabling (ALE) HR master data replication for employees is a 1:1 replication of the values. To ensure that the ALE replication works successfully both the systems must have the same HCM configuration.

Steps for Execution

ALE Configuration Steps

1. Create Users for ALE transfer in both receiving and sending systems.

   Create users in both systems. Provide the same user name and relevant authorizations in both systems. These user IDs are used to logon through the remote connection and to perform IDoc transfers.

   Make the necessary Customizing settings under `IDOC Interface/ Application Link Enabling` ➔ `Basic Settings ➔ Logical Systems`.


   1. Call up transaction `SALE` in the SAP ERP HCM (SSP Client 105) system.
   2. In Customizing, go to `IDOC Interface/ Application Link Enabling ➔ Modelling and Implementing Business Processes ➔ Configure Predefined ALE Business Processes ➔ Human Resources ➔ Master Data Distribution ➔ Distributed HR Master Data`.
   3. Choose `ALE: Original System Active for HR Data`.
   4. Make the following entries:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>ALE</td>
</tr>
<tr>
<td>Sem.abbr.</td>
<td>REPPA</td>
</tr>
<tr>
<td>Value abbr.</td>
<td></td>
</tr>
</tbody>
</table>

5. Save your changes.
6. Choose Continue.
3. Define the logical systems.
Create logical systems for both the SAP ERP HCM system and the SAP S/4HANA, on-premise edition system if system management has not yet done so.

1. Call up transaction SALE in the SAP ERP HCM (SSP Client 105) system.

2. In Customizing, go to IDOC Interface/ Application Link Enabling ➤ Basic Settings ➤ Logical Systems ➤ Define Logical System.

3. Choose New Entries.

4. Make the following entries:

<table>
<thead>
<tr>
<th>Logical System</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Logical Systems with the naming convention 'system name'+'CLNT'+client no, for example, SSPCLNT105 for the sending system.</td>
<td>Enter a name to identify your SAP ERP HCM system.</td>
</tr>
<tr>
<td>Enter Logical Systems with naming convention 'system name'+'CLNT'+client no, for example, SEDCLNT800 for the receiving system.</td>
<td>Enter a name to identify your S/4HANA, on-premise edition system.</td>
</tr>
</tbody>
</table>

**Note**

The distribution of data between systems requires that each system in the network has a unique identification. The logical system is used for this purpose.

5. Save your entries and choose Continue.

6. In the SAP S/4HANA, on-premise edition system (SED client 800) repeat steps 1 through 5 to create the logical systems for the Sending and Receiving system (for example, SEDCLNT800 and SSPCLNT105) if system management has not yet done so.

4. Assign the logical system to the client.
Assign the logical system for SAP ERP HCM system and the SAP S/4HANA, on-premise edition system to the corresponding client if system management has not yet done so.

1. Call up transaction SALE in the SAP ERP HCM (SSP Client 105) system.

2. In Customizing, go to IDOC Interface/ Application Link Enabling ➤ Basic Settings ➤ Logical Systems ➤ Define Logical System.

3. Search for the client you are currently logged in on (in this example 105) and choose the entry to display the details.

4. Check the following entry:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logical System</td>
<td>Logical system: name of the system and client that you are logged in on, for example, SSPCLNT105</td>
</tr>
</tbody>
</table>

5. Save your entry and choose Continue.
6. In the SAP S/4HANA, on-premise edition system (SED client 800): repeat steps 1 through 5 and check the logical system for the SAP S/4HANA, on-premise edition system/client (for example SEDCLNT800).

5. Create RFC connections.
   1. Call up transaction SM59 in the SAP ERP HCM system (SSP Client 105).
   2. Choose Create in the Configuration of RFC Connections view.
   3. Make the following entries in the RFC Destination view:

<table>
<thead>
<tr>
<th>Tabs</th>
<th>Field Name</th>
<th>User Action</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFC Destination</td>
<td>RFC Destination</td>
<td>Enter a destination name, for example, SEDCLNT800</td>
<td>&lt;S/4HANA System ID&gt;CLNT&lt;Client&gt;</td>
</tr>
<tr>
<td>Connection Type</td>
<td></td>
<td>3 ABAP Connection</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td>Enter a description for the RFC</td>
<td></td>
</tr>
<tr>
<td>Technical Settings</td>
<td>Load Balancing Status</td>
<td>Select ‘NO’</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Target Host</td>
<td>Enter the S/4HANA, on-premise edition host – fully qualified with domain</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instance No.</td>
<td>Enter the Instance number, for example, 45</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Save to Database as</td>
<td>Host or IP Address</td>
<td>Save the target host or message server internally in the database either as the host name or as its IP address.</td>
</tr>
<tr>
<td>Logon &amp; Security Tab</td>
<td>Client</td>
<td>Enter the Receiver System client, for example 800</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User</td>
<td>User ID</td>
<td>Created in “Create Users for ALE transfer ...”</td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>Enter user password</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Current User</td>
<td>Not checked</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Trust Relationship</td>
<td>“No” Checked</td>
<td></td>
</tr>
<tr>
<td>Special Options Tab</td>
<td>Special Flags</td>
<td>Not checked</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Activate RFC Trace</td>
<td>Not checked</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Trace Export Methods</td>
<td>Default Gateway Value</td>
<td></td>
</tr>
</tbody>
</table>
4. Save your changes.
5. Choose Remote Logon to test the RFC.
6. In the SAP S/4HANA, on-premise edition system (SED client 800): repeat steps 1 through 5 and create an ABAP connection SSPCLNT105 pointing to the SAP ERP HCM system giving logon credentials to client 105.

6. Maintain the distribution model.
The distribution model is created in the original system (sending system) and then distributed to other systems.
You can create a distribution model using the following steps:
1. Call up transaction BD64, in the SAP ERP HCM system (SSP client 105).
2. Choose Create Model view (CTRL+F4) in the Distribution Model view (in change mode).
3. In the Create Model View dialog box, enter a short text (for example, SAP HCM to SAP S/4) and a technical name (for example, <ZSSP_SED>).
4. Choose Continue and save your entries.
5. Select the newly created model and choose Add Message Type.
6. In the Add Message Type dialog box, enter the logical system of the SAP ERP HCM system in the Sender field (SSPCLNT105) and the logical system of the SAP S/4HANA, on-premise edition system in the Receiver field (SEDCLNT800). As message type, select HRMD_A.
7. Expand the model view and double-click No filter set.
8. Select Create Filter Group in the Change Filter view and restrict the replication to the required objects.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of related objects</td>
<td>CP</td>
</tr>
<tr>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Field name</td>
<td>Value</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Infotype</td>
<td>0000 0001 0002 0003 0006 0007 0009 0105 1000 1001</td>
</tr>
<tr>
<td>Object Type</td>
<td>CP P</td>
</tr>
</tbody>
</table>

9. Choose **Enter**.
10. Save your entry.
11. Select the model view that you have created and go to **Environment > Generate Partner Profiles**.
12. Select **Transfer IDOC Immediately** and **Trigger Immediately** in the **Generate Partner Profile** view.
13. Choose **Execute**. Go back to the main view.
    If it has been executed successfully, a green list is displayed.
14. Select the model view again and choose **Edit > Model view > Distribute**.
15. Choose **Continue**.
    A list is displayed with a message to inform you that the model view has been successfully distributed.

7. Activate the change pointer.
   1. Call up transaction **SALE** in the SAP ERP HCM (SSP Client 105) system.
   2. In Customizing, go to **IDOC Interface/ Application Link Enabling > Modelling and Implementing Business Process > Master Data Distribution > Replication of Modified Data > Activate Change Pointers for Message Types**.
   3. In the change view **Activate Change pointers for Message Type**, verify that the activation is set for message type **HRMD_A**.

8. Maintain the port.
   1. Call up transaction **WE21** in the SAP ERP HCM (SSP Client 105) system.
      Alternatively, you can go to Customizing under **SAP Menu > Tools > ALE > ALE Administration > Runtime Settings > Port Maintenance**.
   2. Select **Transactional RFC** in the navigation panel of the **Ports in IDOC processing** view.
   3. Choose **Create**.
   4. In the **Ports in IDoc processing** view, select **own port name** and enter a technical name, for example `<SEDCLNT800>`. 
5. Choose Enter.

6. Make the following entries on the Creating a tRFC port view:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for your port name.</td>
</tr>
<tr>
<td>Version</td>
<td>X</td>
</tr>
<tr>
<td>IDoc record types SAP Release 4.x</td>
<td>Enter the technical name of your RFC destination for the receiving SAP S/4HANA, on-premise edition system, for example, SEDCLNT800.</td>
</tr>
<tr>
<td>RFC destination</td>
<td>Enter the technical name of your RFC destination for the receiving SAP S/4HANA, on-premise edition system, for example, SEDCLNT800.</td>
</tr>
</tbody>
</table>

7. Save your entries.

9. Create partner profiles

1. Call up transaction WE20 in the SAP ERP HCM (SSP Client 105) system.
2. Select Partner Type LS in the navigation panel of the Partner profiles view.
3. Choose Create and make the following entries:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partner No.</td>
<td>Enter the ID for your partner no. Your ALE partner is an SAP system that is addressed by your system (using RFC), in this case the SAP S/4HANA, on-premise edition system, for example, SEDCLNT800</td>
</tr>
<tr>
<td>Partn. Type</td>
<td>LS</td>
</tr>
</tbody>
</table>

4. On the Post processing: permitted agent tab, specify the job (person or group of people) to be notified if processing errors occur.
5. In the Outbound parmtrs. section, choose Create outbound Parameter.
6. In the Partner profiles: Outbound parameters view, make the following entries:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Type</td>
<td>HRMD_A</td>
</tr>
<tr>
<td>Receiver Port</td>
<td>Enter the technical Name of the created port, for example, SEDCLNT800</td>
</tr>
<tr>
<td>Pack. Size</td>
<td>For example, 100 (for the first testing use 1)</td>
</tr>
<tr>
<td>Output Mode</td>
<td></td>
</tr>
<tr>
<td>Transfer IDoc Immed.</td>
<td>X</td>
</tr>
</tbody>
</table>
7. Save your entries.
8. Call up transaction WE20 in the SAP S/4HANA, on-premise edition system (SED client 800).
9. Select Partner Type LS in the navigation panel of the Partner profiles view.
10. Choose Create and make the following entries:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partner No.</td>
<td>Enter the ID for your partner no. Your ALE partner is an SAP system</td>
</tr>
<tr>
<td></td>
<td>that is addressed by your system (using RFC), in this case the SAP</td>
</tr>
<tr>
<td></td>
<td>ERP HCM system, for example SSPCLNT105</td>
</tr>
<tr>
<td>Partn. Type</td>
<td>LS</td>
</tr>
</tbody>
</table>

11. On the Post processing: permitted agent tab, specify the job (person or group of people) to be notified if processing errors occur.
12. In the Inbound parmtrs. section, choose Create inbound Parameter.
13. In the Partner profiles: Inbound parameters view in the Inbound options section, make the following entries:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Type</td>
<td>HRMD_A</td>
</tr>
<tr>
<td>Process Code</td>
<td>HRMD</td>
</tr>
</tbody>
</table>
10. Run the initial distribution.
   1. Call up transaction PFAL in the SAP ERP HCM system (SSP client 105)
   2. On the **HR: ALE Distribution of HR Master Data** view, specify the required Object Type, Object ID, and so on, before executing and choose the following option:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert (complete distribution: delete in target system, re-create)</td>
<td>X</td>
</tr>
</tbody>
</table>

3. Choose **Execute**.

11. Check IDocs.
    In the receiving system (SED client 800) check the inbound IDocs (transaction: WE02/WE05). Some inbound IDocs may have errors. This may be due to some HR specific Data and configuration issues in the receiving system. In this case, contact an HR functional consultant.

12. Define a background job for delta distribution.
    To schedule the background job in the sending system (SSP client 105), create a variant of ABAP program RBDMIDOC.
    1. Create a variant.
       1. Go to transaction SE38 in the SAP ERP HCM (SSP Client 105) system.
          Alternatively, you can go to customizing under SAP Menu ➤ Tools ➤ ABAP Workbench Development ➤ ABAP Editor.
       2. On the **ABAP Editor: Initial Screen**, enter RBDMIDOC in the Program field.
       3. Choose **Execute**.
       4. In the **Creating IDoc Type from Change Pointers** view, enter the following value:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Type</td>
<td>HRMD_A</td>
</tr>
</tbody>
</table>

5. Choose **Save as Variant** to create a new variant.
6. On the **Variant Attributes** view, enter the following values:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variant Name</td>
<td>YK_HRMD_A</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the variant</td>
</tr>
</tbody>
</table>

7. Save your entries.

---

### Note

A system notification confirms the creation.

---

2. **Schedule a job**

1. Call up transaction `SM36` in the SAP ERP HCM (SSP Client 105) system. Alternatively, you can go to Customizing under `SAP Menu > System > Services > Jobs > Define Job`.

2. In the **Define Background Job** view, choose `Define Job using Wizard` (Ctrl+F1).

3. In the **Create a Job** dialog box, choose **Continue**.

4. In the **General Job Information** dialog box, make the following entries:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>YK_ALE_DELTA_HRMD_A</td>
</tr>
<tr>
<td>Job Class</td>
<td>C – Low priority</td>
</tr>
<tr>
<td>Job Status</td>
<td>Scheduled</td>
</tr>
<tr>
<td>Target Server</td>
<td></td>
</tr>
</tbody>
</table>

5. Choose **Continue**.

6. In the **Job-Definition: Job step** dialog box, select **ABAP program step** and choose **Continue**.

7. In the **ABAP program step** dialog box, make the following entries:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABAP program name</td>
<td>RBDMIDOC</td>
</tr>
<tr>
<td>Variant</td>
<td>YK_HRMD_A</td>
</tr>
<tr>
<td>Execution language</td>
<td>EN</td>
</tr>
</tbody>
</table>

8. Choose **Continue**.

9. In the **Multi-step option** dialog box, choose **Continue**.

10. In the **Job Definition: Start conditions** view, choose **Immediately**. Choose **Continue**.
11. In the **Def. of start immediately** dialog box, select the **Period** checkbox in the **Periodic jobs** section and choose **Continue**.

12. In the **Period definition** dialog box, choose **None of the Above**.

13. Choose **Other Periods**.

14. In the **Other Period** dialog box, schedule the service for a convenient time interval.

15. Choose **Create**.

16. Choose **Continue**.

17. In the **Set job** dialog box, choose **Complete** to finish the setup.

**Employee-Business Partner Synchronization**

After employee replication, you must execute the employee synchronization. For more details, refer to section **Employee-Business Partner Synchronization** [page 61].

### 7.16.2.3 Running SAP ERP HCM on the Same Instance with SAP S/4HANA (Co-deployed)

The purpose of this section is to enable you to run SAP S/4HANA HCM on the same instance with SAP S/4HANA. All the required steps to implement this integration are listed in the Customizing documentation under

> Personnel Management > SAP S/4HANA for Human Resources > Synchronization of Business Partner for SAP HCM Employee Role

All the existing employees have to be synchronized during business downtime. For more information, refer to the section **Employee-Business Partner Synchronization** [page 61].

**Prerequisites**

You must have an existing SAP ERP HCM solution as your HR master data system.

**Notes**

**Report like HRALXSYNC (report)**

You cannot use this sync report for employee synchronization in SAP S/4HANA. For any other (organizational unit) object synchronization, you can use this report.

**Transaction PRAA**

This transaction was used for employee vendor creation in the SAP ERP system for travel expenses. You cannot create employee vendors using this transaction and it is no longer valid in the SAP S/4HANA system.
7.16.3 Conversion from SAP ERP to SAP S/4HANA

This section is relevant only if you are converting from SAP ERP to SAP S/4HANA.

There are 2 processes involved in the conversion to SAP S/4HANA:

- CVI Conversion in the SAP ERP system
  This can be considered as a pre-conversion process which has to be performed in the SAP ERP system. This is relevant only if you are using employee vendor in the SAP ERP system. For more information about the CVI conversion process, refer to the SAP Note 2265093.

- Employee-BP Synchronization in the SAP S/4HANA System
  This is the post conversion process that has to be performed in the SAP S/4HANA system during business downtime. For more information, refer to section Employee-Business Partner Synchronization [page 61].

BP Synchronization Data Models for SAP ERP and SAP S/4HANA

Source Data Model (SAP ERP)

In the above data model, each central person can have a single or multiple PERNR associated with it. A vendor can be created for a PERNR. This is an optional step. In case of concurrent employment, multiple vendors can be created for a PERNR.

Example: If a record 100(CP) exists and a PERNR 500 (P) exists for the CP, a business partner BP1 is created for this CP. You can create vendors for this PERNR. For example, V1, V2. Another business partner is created for each
of these associated vendors, for example, BPV1, BPV2 (if CVI is active during Vendor creation). Hence in the SAP ERP model, each CP can have 2 or more BP associated, depending on the number of vendors and configuration.

**Note**

To reuse the BP or to create a new BP in Person category in the CVI for vendor you can apply the following SAP notes:

- 2539457: if CVI is active, during Vendor creation or conversion BP is created in Person category.
- 2542175: if CVI is active, during Vendor creation or conversion Employee-BP is reused (instead of creating new BP for the Vendor).

**Target Data Model (SAP S/4HANA)**

**Compatible Data Model (S/4)**

In the new data model, each Central Person (CP) is associated with PERNRs. If a BP is already associated with the CP, then information is synchronized to this BP and BP is linked to the user identity (if user is maintained in infotype 105 subtype 0001 for the employee).

If no BP exists for the Employee (CP-BP relationship) then the system checks for associated vendor. If one vendor exists for the employee with BP of Person category then the BP (of category Person) associated with the vendor is linked with the CP and user identity. If no vendor exists, a new vendor is created for PERNR if Permanent address (subtype 1 of Infotype 6) and Payment (Main Bank or Travel Expense – subtype 0 or 2 of Infotype 9) is assigned for the employee. This is a mandatory step.

If Employee-BP (HRP1001 table, CP-P, and CP-BP relationship exist) also Vendor-BP (of type Person category) exist, then sync report does not update the Employee BP with Vendor roles. Vendor BP will be reported in the application log. It is a warning or a conflicting scenario, as which BP to be linked with Employee and Vendor is not known (as it depends on business scenario). In such scenario, customer need to remove one of the BP or relationships.
In case of concurrent employment or multiple assignment in ERP system vendor exists for each assignment, then during employee synchronization:

- Employee-BP will be linked with minimum-active PERNR's vendor. In case minimum active PERNR's vendor has different BP (Case 1: HRP1001 CP-BP exist in ERP and vendor also has BP & Case 2: Vendor has BP of category Organization) then Employee-BP will not be linked with the vendor.
- Only loosely coupled BPs exist. Loosely coupled BP will be created for additional assignment (PERNRs). For more information refer to 2517507.

Note: Vendor has BP of type Organization category, then it will NOT be deleted, but a warning message is displayed in the application log so that BP of type Organization category is found. Customer can remove the BP or retain it as standalone BP in case it is still consumed in business processes.

**Example**: If a record 100(CP) exists, then a PERNR 500 (P) is associated with it. After the integration, if a BP1 is found that is associated with this CP, then this data is used for synchronization. The user identity is also linked to this BP1. If vendors are associated with this PERNR, for example, V1. Vendor has BPV1. In case, the BP1 already exists for the CP 100, then a warning message is displayed that multiple BPs found. In case, no BP exists for CP 100, then the Vendor BP, BPV1 is used for synchronization in case BPV1 is of category Person. Otherwise this BP will be reported in the warning message and new BP of category Person will be created and linked with the objects.

**Differences Between SAP ERP and SAP S/4HANA Data model**

- Synchronization
  This process was optional and base on switch setting in the SAP ERP system, but it is a mandatory step in the SAP S/4HANA system.
- Vendor and BP relation
  An employee could have multiple vendors and BPs associated with his PERNR in the SAP ERP system. In SAP S/4HANA a single BP and Vendor is created for an employee. Multiple company segments (LFB1) based on employment (Company Code changes) is still relevant in both systems.

  **Note**: In case of concurrent employment or multiple assignment loosely coupled BP will be created for additional assignment (PERNRs). Refer note 2517507 for more information.

  **User Identity**
  - In SAP S/4HANA, User identity is connected to BP only it is maintained in Infotype 105.
  - In the SAP ERP system, workplace address was modeled using the BP (Organization) -> BP (Employee) relationship. In SAP S/4HANA, Workplace Address information (business phone, e-mail) is stored in workplace address connected to BP.

  **Note**: You can only maintain one workplace address for an employee.

  - In SAP S/4HANA, if a BP and user relationship exists then it’s always modeled as 1:1. Hence, it is recommended to use only single user (SY-UNAME) across all employment (P) of employee(CP).
• Address Types and Identification
  In SAP ERP, employees were linked BP through Personnel Number field in BP. In SAP S/4HANA, New Address types (HCM001, private address of employee) and New Identification (HCM001) are created for BP employee.

  **i Note**
  In S/4HANA it is recommended to use HRP1001 table (relationship P-CP and CP-BP) to determine the BP for an Personnel Number (PERNR).

**Conversion Scenarios for Employee Vendors in SAP S/4HANA**

In SAP S/4HANA, each employee will have a corresponding business partner and vendor (if address, bank, and configurations exist) for the employee. So any vendors created manually in the SAP ERP system (using the transaction PRAA or other transactions) have to be migrated consistently into the SAP S/4HANA system. The following scenarios might exist:

• No business partner or vendor exists for an employee
  After the synchronization business partner is created. Vendor will be created if the appropriate configurations and information is maintained like Permanent address (subtype 1 of infotype 6) and Payment (Main Bank or Travel Expense – subtype 0 or 2 of Infotype 9) is assigned for the employee.

  **i Note**
  In case of Concurrent Employment or multiple assignment loosely coupled BP will created for additional assignment (PERNRs). Refer note 2517507 for more information.

• Only a business partner exists
  In this case the business partner has to be enriched. For the BP vendor role and the vendor has to be created (if appropriate configurations and information are maintained) in case Vendor and payment information is maintained for the employee (LFB1-PERNR as to be filled).

• A vendor for an employee exists with LFB1-PERNR but is assigned to a different business partner of category Person than the business partner related to the Central Person of PERNR. This will be error scenario, customer need to correct one of the BusinessPartner and need to adjust the relationships.

The first two scenarios are transformed using the Employee-Business partner Synchronization. This is triggered by any change made on Employee side effecting integration relevant infotypes (0, 1, 2, 6, 9, 17, 32, 105). In addition, a report /SHCM/RH_SYNC_BUPA_FROM_EMPL scheduled in batch every 24 hours transfers time-dependent employee data into the business partner persistency.

**7.16.4 Employee-Business Partner Synchronization**

The following steps enable you to synchronize employee information to the business partners. This synchronization is a mandatory activity for SAP S/4HANA to make sure the follow-up activities and the CDS views work.

For more information, you can also refer to the Customizing under [Personnel Management ➤ SAP S/4HANA for Human Resources ➤ Synchronization of Business Partner for SAP HCM Employee Role](#).
The following activity must be set during the initial business downtime before production starts.

- In case of large volume of employee data, standard report /SHCM/RH_SYNC_BUPA_FROM_EMPL will take lot of time to synchronize the employees. You could try the recommendations in FAQ note for 2409229 regarding process the employees in parallel jobs.

**Notes (SAP S/4HANA)**

**HRALXSYNC (report)**

You cannot use this sync report for employee synchronization in SAP S/4HANA. For any other (organizational unit) object synchronization, you can use this report.

**Transaction PRAA**

This transaction was used for employee vendor creation in the SAP ERP system for travel expenses. You cannot create employee vendors using this transaction and it is no longer valid in the SAP S/4HANA system.

**Prerequisites**

- Set the following switches in the table T77S0:
  - Set HRALX PBPO to **OFF**: Integration Employee or BP Activated.
    - **Note**
      
      From 1709 SPS1 or after applying the SAP note 2535438 and 2549563 in 1709, set HRALX HRAC to ‘X’ and HRALX PBPO to ‘ON’ to synchronize Employee information.
    - **HRALX PNUMB Business Partner Number Assignment (Employee) and HRALX PSUBG Business Partner Subgroup (Employees):** use this to provide to different number range to BP. Refer to the T77S0 switch documentation.
    - **PLOGI** Integration Plan Version / Active Plan Version: determines the active integrated plan version.
  - All other switches under HRALX are not relevant in SAP S/4HANA for Employee BP Synchronization.
  
  - Set up the BP customizing for CVI and vendor account
  - CP (central person) should exist for all the employee records (HRP1001 table should have CP-P relationship record for all the employees).
  - All the employee’s should have atleast infotype 0-Actions, 1-Organizational Assignment, and 2-Personal Data maintained.
For more information regarding the customizing, see Requirement section in the Customizing document under Personnel Management > SAP S/4HANA for Human Resources > Synchronization of Business Partner for SAP HCM Employee Role.

7.16.4.1 SAP S/4HANA BUPA Synchronization Report

You can use the BUPA Synchronization Report (technical name: /SHCM/RH_SYNC_BUPA_FROM_EMPL) to synchronize employee data stored in HCM master data persistence (infotypes) with the business partner, vendor, and linking BP to User (if Infotype 105 subtype 0001 is maintained) and WorkPlace Address.

Employee synchronization report (technical name: /SHCM/RH_SYNC_BUPA_FROM_EMPL) processes employees:

- Employee(s) HCM infotypes are modified from last synchronization
- Employee(s) failed during previous synchronization processing
- Employee(s) has split records (records which were delimited like the begin date of the split record is on the synchronization date or end date of the split record was yesterday) were synchronized

For more information, you can also refer to the Customizing under:

- Personnel Management > SAP S/4HANA for Human Resources > Synchronization of Business Partner for SAP HCM Employee Role
- Personnel Management > SAP S/4HANA for Human Resources > Define Default Vendor Data for Employees in Role FI Supplier

Data is synchronized if employee data is created or changed in the following ways:

- Inbound processing from Employee Central
  The synchronization is triggered using the following BAdI implementations: HRPAD00INFTYDB: /SHCM/TRIGGER_BUPA_SYNCHRPAD00INFTY: /SHCM/TRIG_BUPA_SYNC
- Inbound processing using ALE
  The synchronization is triggered using the following BAdI implementation: HRALE00INBOUND_IDOC: /SHCM/BUPA_SYNC_TRIG

**Note**

This implementation is not active (by default).

- Personnel master data maintenance (for example, transaction PA30)
  The synchronization is triggered using the following BAdI implementations:
  - HRPAD00INFTYDB: /SHCM/TRIGGER_BUPA_SYNC
  - HRPAD00INFTY: /SHCM/TRIG_BUPA_SYNC

**Note**

- HCM master data is time-independent, but some business partner data is not. Therefore, schedule this report to run on a daily basis to update the business partner and receive up-to-date employee data. You can customize and use the standard job defined in SJOBREPO.
- If a synchronization is unsuccessful, all the employee data is updated in the next synchronization run.
Field mapping used for employee synchronization

BP Fields:
- BP Grouping: If BP grouping is created with BPEE then it will be considered for BP creation otherwise:
  1. In case switch HRALX PNUMB is 1 and internal number range scenario, then set true value to XINST (Standard Grouping for Internal Number Assignment) for the BP Grouping, that is, BP group of internal number range type and field XINST is set is considered.
  2. In case HRALX PNUMB is 2 or 3 then BP grouping should be same as switch HRALX PSUBG in T77S0.
- BP category: 1 (Person)
- Identification Category:
  - Employee: HCM001
- Identification ID: minimum PERNR in case of CE or single assignment the same PERNR or 105-ECUS in case of SAP SuccessFactors Integration is used.
- Roles:
  - Employee: BUP003, 1511- till SP1: FLVN01, 1511 SP2 & higher releases FLVNO0.

<table>
<thead>
<tr>
<th>Employee</th>
<th>First Name</th>
<th>2</th>
<th>VORNA</th>
<th>BUT000 · NAME_FIRST</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>2</td>
<td>NACHN</td>
<td>BUT000 · NAME_LAST</td>
<td></td>
</tr>
<tr>
<td>Middle Name</td>
<td>2</td>
<td>MIDNM</td>
<td>BUT000 · NAME_MIDDLE</td>
<td></td>
</tr>
<tr>
<td>Second Name</td>
<td>2</td>
<td>NACH2</td>
<td>BUT000 · NAME_LST2</td>
<td></td>
</tr>
<tr>
<td>Initials</td>
<td>2</td>
<td>INITS</td>
<td>BUT000 · INITIALS</td>
<td></td>
</tr>
<tr>
<td>Academic Title 1</td>
<td>2</td>
<td>TITEL</td>
<td>TSAD2</td>
<td>BUT000-TITLE_ACA1</td>
</tr>
<tr>
<td>Title</td>
<td>2</td>
<td>Based on ANRED and GESCH</td>
<td>BBP_TSAD3HR or TSAD3HR</td>
<td>BUT000 · TITLE</td>
</tr>
<tr>
<td>Academic Title 2</td>
<td>2</td>
<td>TITL2</td>
<td>TSAD2</td>
<td>BUT000-TITLE_ACA2</td>
</tr>
<tr>
<td>Name Supplement</td>
<td>2</td>
<td>NAMZU</td>
<td>TSAD5</td>
<td>BUT000-TITLE_ROYL</td>
</tr>
<tr>
<td>Name Affix 1</td>
<td>2</td>
<td>VORSW</td>
<td>TSAD4</td>
<td>BUT000-PREFIX1</td>
</tr>
<tr>
<td>Name Affix 2</td>
<td>2</td>
<td>VORS2</td>
<td>TSAD4</td>
<td>BUT000-PREFIX2</td>
</tr>
<tr>
<td>Field description</td>
<td>Infotype</td>
<td>Field Name</td>
<td>Comments</td>
<td>BP Field name</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
<td>------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>Gender</td>
<td>2</td>
<td>GESCH</td>
<td>Value 1 is mapped to 2 and vice versa because of domain value differences</td>
<td>BUT000 - XSEXF or XSEXV</td>
</tr>
</tbody>
</table>
| Preferred Language| 2        | SPRSL      |          | BUT000 - LANGU_CAORR  
<p>|                   |          |            |          | BUT000 - BU_LANGU |
| Nationality       | 2        | NATIO      |          | BUT000 - NATIO |
| Date of Birth     | 2        | GBDAT      |          | BUT000 - BIRTHDT |
| Name at Birth     | 2        | NAME2      |          | BUT000 - NAME_LAST2 |
| Nick name         | 2        | RUFNM      |          | BUT000 - NICK_NAME |
| Place of Birth    | 2        | GBORT      |          | BUT000 - BIRTHPL |
| Marital Status    | 2        | FAMST      | BBP_TSAD3HR or TB027HR | BUT000 - MARST |
| Search term 1     | 2        | NCHMC      |          | BUT000 - BU_SORT1 |
| Search term 2     | 2        | VNAMC      |          | BUT000 - BU_SORT2 |
| Full Name         | 2        |            | CNAME or ENAME or Concatenation of VORNA MIDNM NACHN | BUT000 - NAME1_TEXT |
| Address           |          |            |          |                |
| From Date         | 6        | BEGDA      | Permanent Address (subtype 1) is synchronized | BUT020 - ADDR_VALID_FRO M |
| End Date          | 6        | ENDDA      |          | BUT020 - ADDR_VALID_TO |
| Country           | 6        | LAND1      |          | ADRC - COUNTRY |
| Region            | 6        | STATE      |          | ADRC - REGION |</p>
<table>
<thead>
<tr>
<th>Field description</th>
<th>Infotype</th>
<th>Field Name</th>
<th>Comments</th>
<th>BP Field name</th>
</tr>
</thead>
<tbody>
<tr>
<td>City</td>
<td>6</td>
<td>ORT01</td>
<td></td>
<td>ADRC·CITY1</td>
</tr>
<tr>
<td>District</td>
<td>6</td>
<td>ORT02</td>
<td></td>
<td>ADRC·CITY2</td>
</tr>
<tr>
<td>Postal Code</td>
<td>6</td>
<td>PSTLZ</td>
<td></td>
<td>ADRC·POST_CODE1</td>
</tr>
<tr>
<td>Street</td>
<td>6</td>
<td>STRAS</td>
<td></td>
<td>ADRC·STREET</td>
</tr>
<tr>
<td>Street 2</td>
<td>6</td>
<td>ADR03</td>
<td></td>
<td>ADRC·STR_SUPPL1</td>
</tr>
<tr>
<td>Street 3</td>
<td>6</td>
<td>ADR04</td>
<td></td>
<td>ADRC·STR SUPPL2</td>
</tr>
<tr>
<td>Street 4</td>
<td>6</td>
<td>LOCAT</td>
<td></td>
<td>ADRC·STR_SUPPL3</td>
</tr>
<tr>
<td>House number supplement</td>
<td>6</td>
<td>POSTA</td>
<td></td>
<td>ADRC·HOUSE_NUM2</td>
</tr>
<tr>
<td>c/o</td>
<td>6</td>
<td>NAME2</td>
<td></td>
<td>ADRC·NAME_CO</td>
</tr>
<tr>
<td>Building Code</td>
<td>6</td>
<td>BLDNG</td>
<td></td>
<td>ADRC·BUILDING</td>
</tr>
<tr>
<td>Floor</td>
<td>6</td>
<td>FLOOR</td>
<td></td>
<td>ADRC·FLOOR</td>
</tr>
<tr>
<td>House Number</td>
<td>6</td>
<td>HSNMR</td>
<td></td>
<td>ADRC·HOUSE_NUM1</td>
</tr>
<tr>
<td>telephone</td>
<td>6</td>
<td>TLNR</td>
<td></td>
<td>ADCP·TEL NUM-BER</td>
</tr>
<tr>
<td>Payment</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Account Holder Name</td>
<td>1</td>
<td>EMFTX</td>
<td>If infotype 9-EMFTX is not present then map infotype 1 ENAME</td>
<td>BUT0BK-KOINH</td>
</tr>
<tr>
<td>Bank</td>
<td>9</td>
<td>BANKS</td>
<td></td>
<td>BUT0BK·BANKS</td>
</tr>
<tr>
<td>Bank Account</td>
<td>9</td>
<td>BANKN</td>
<td></td>
<td>BUT0BK·BANKN</td>
</tr>
<tr>
<td>Control Key</td>
<td>9</td>
<td>BKONT</td>
<td>If Travel Expenses (subtype 2) Bank information exists then it is synchro-</td>
<td>BUT0BK·BKONT</td>
</tr>
<tr>
<td>Bank Key</td>
<td>9</td>
<td>BANKL</td>
<td>nized to Business Partner or Vendor else Main Bank (subtype 0) is synchr-</td>
<td>BUT0BK·BANKL</td>
</tr>
<tr>
<td>Reference specifications for bank details</td>
<td>9</td>
<td>BKREF</td>
<td>oized. If both do not exist</td>
<td>BUT0BK·BKREF</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field description</th>
<th>Infotype</th>
<th>Field Name</th>
<th>Comments</th>
<th>BP Field name</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBAN No.</td>
<td>9</td>
<td>IBAN</td>
<td>then vendor will not</td>
<td>BUTOBK - IBAN</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>be created.</td>
<td>BUTOBK - BK_VALID_FROM</td>
</tr>
<tr>
<td>Valid From</td>
<td>9</td>
<td>BEGDA</td>
<td></td>
<td>BUTOBK - BK_VALID_FROM</td>
</tr>
<tr>
<td>Valid To</td>
<td>9</td>
<td>ENDDA</td>
<td></td>
<td>BUTOBK - BK_VALID_TO</td>
</tr>
</tbody>
</table>

**Vendor Company Code**

<table>
<thead>
<tr>
<th>Vendor Company Code</th>
<th>BUKRS</th>
<th>BUKRS</th>
<th>LFB1 - BUKRS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ZLSCH</td>
<td>ZLSCH</td>
<td>LFB1 - ZWELS</td>
</tr>
<tr>
<td></td>
<td>PERNR</td>
<td>PERNR</td>
<td>LFB1 - PERNR</td>
</tr>
</tbody>
</table>

| Reconciliation account | (see comment) | Read from /SHCM/ RECON based on Employee’s company code (IT0001- BUKRS) | LFB1 - AKONT |

### Note

You can implement note 2517507 to map additional fields during Vendor synchronization and also using the concept like reference Vendor concept the fields mentioned above (in field mapping) are copied from reference Vendor. Refer 2517507 documentation for more information.

### Field mapping for Workplace Address:

- In case User (infotype 105, subtype 0001) is maintained for the Employee. During employee synchronization, if the user is of type 00 (user’s old Type 3 Address, that is, USR21-IDADTYPE: 00), then the existing workplace address data is retained and only the following information is updated or overwritten if present in the infotypes.
- In case no user is maintained then following information is updated as workplace address.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Infotype</th>
<th>Field Name</th>
<th>Comments</th>
<th>BP Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>1</td>
<td>ORGEH</td>
<td></td>
<td>ADCP - DEPARTMENT</td>
</tr>
<tr>
<td>Function</td>
<td>1</td>
<td>PLANS</td>
<td></td>
<td>ADCP - FUNCTION</td>
</tr>
<tr>
<td>Room Number</td>
<td>32</td>
<td>ZIMNR</td>
<td></td>
<td>ADCP - roomnumber</td>
</tr>
<tr>
<td>Building Number</td>
<td>32</td>
<td>GEBNR</td>
<td></td>
<td>ADCP - building</td>
</tr>
<tr>
<td>Field Description</td>
<td>Infotype</td>
<td>Field Name</td>
<td>Comments</td>
<td>BP Field Name</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
<td>------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>Telephone</td>
<td>105</td>
<td></td>
<td>In case SAP Success Factors integration is used Infotype 105, Sub-type ECPB is used else Infotype 105, subtype 0020 is used.</td>
<td>ADR2 · teln_nr_long</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><img src="https://example.com" alt="Note" /> Additional condition that r3_user = ‘1’</td>
<td></td>
</tr>
<tr>
<td>Cell Phone</td>
<td>105</td>
<td></td>
<td>In case SAP Success Factors integration is used, Infotype 105, Subtype ECPC is used else Infotype 105, subtype CELL is used.</td>
<td>ADR2 · teln_nr_long</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><img src="https://example.com" alt="Note" /> Additional condition that r3_user = ‘3’</td>
<td></td>
</tr>
</tbody>
</table>
| E-Mail Address    | 105      |            | infotype 105, subtype 10 | ADR6 · flgdefault = ‘X’  
ADR6- SMTP_ADDR  
|                   |          |            | | |

### 7.16.4.1.1 Authorizations

Human Resources uses the authorization concept provided by the SAP NetWeaver AS for ABAP or AS Java. Therefore, the recommendations and guidelines for authorizations as described in the SAP NetWeaver AS Security Guide ABAP and SAP NetWeaver AS Security Guide Java also apply.

The SAP NetWeaver authorization concept is based on assigning authorizations to users based on roles. For role maintenance, use the profile generator (transaction PFCG) on the AS ABAP and the User Management Engine’s user administration console on the AS Java.

**Note**

For more information about how to create roles, see the information on user administration and authentication in the SAP NetWeaver Security Guide under the relevant release of SAP S/4HANA [SAP NetWeaver for SAP S/4HANA Security Guide](#).

### Standard Roles

The table below shows the standard roles that are used.
Role | Front-end Role | Back-end Role | Both (Front-end + Back-end) | Description
--- | --- | --- | --- | ---
SAP_BR_ADMINISTRATOR_HRINFO | Yes | - | - | Administrator App (For example, Monitoring Employee Synchronization)
SAP_COM_CSR_1001_OP | - | Yes | - | Monitoring Employee Synchronization App

### Standard Authorization Objects

The table below shows the security-relevant authorization objects that are used.

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Field</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B_BUPA_RLT (Business Partner: BP Roles)</td>
<td>ACTVT</td>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RLTP</td>
<td>BP Role</td>
<td></td>
</tr>
<tr>
<td>B_BUPA_GRP</td>
<td>BEGRU</td>
<td>Authorization Group</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACTVT</td>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td>B_BUPA_GRPT</td>
<td>ACTVT</td>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td>F_LFA1_APP (Vendor: Application Authorization)</td>
<td>ACTVT</td>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>APPKZ</td>
<td>Customer and Vendor Master Data Application Authorization</td>
<td></td>
</tr>
<tr>
<td>F_LFA1_BUK (Vendor: Authorization for Company Codes)</td>
<td>BUKRS</td>
<td>Company Code</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACTVT</td>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td>F_LFA1_GEN (Vendor: Central Data)</td>
<td>ACTVT</td>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td>F_LFA1_GRP (Vendor: Account Group Authorization)</td>
<td>KTOKK</td>
<td>Vendor account group</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACTVT</td>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td>P_ORIGIN (HR: Master Data)</td>
<td>INFTY</td>
<td>Infotype</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUBTY</td>
<td>Subtype</td>
<td></td>
</tr>
<tr>
<td>Authorization Object</td>
<td>Field</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------</td>
<td>-------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td></td>
<td>AUTHC</td>
<td></td>
<td>Authorization level</td>
</tr>
<tr>
<td></td>
<td>PERSA</td>
<td></td>
<td>Personnel Area</td>
</tr>
<tr>
<td></td>
<td>PERSG</td>
<td></td>
<td>Employee Group</td>
</tr>
<tr>
<td></td>
<td>PERSK</td>
<td></td>
<td>Employee Subgroup</td>
</tr>
<tr>
<td></td>
<td>VDSK1</td>
<td></td>
<td>Organizational Key</td>
</tr>
<tr>
<td>PLOG (Personnel Planning)</td>
<td>PLVAR</td>
<td></td>
<td>Plan Version</td>
</tr>
<tr>
<td></td>
<td>OTYPE</td>
<td></td>
<td>Object Type</td>
</tr>
<tr>
<td></td>
<td>INFOTYP</td>
<td></td>
<td>Infotype</td>
</tr>
<tr>
<td></td>
<td>SUBTYP</td>
<td></td>
<td>Subtype</td>
</tr>
<tr>
<td></td>
<td>ISTAT</td>
<td></td>
<td>Planning Status</td>
</tr>
<tr>
<td></td>
<td>PPFCODE</td>
<td></td>
<td>Function Code</td>
</tr>
<tr>
<td>S_USER_GRP (User Master Maintenance: User Groups)</td>
<td>CLASS</td>
<td></td>
<td>User group in user master maintenance</td>
</tr>
<tr>
<td></td>
<td>ACTVT</td>
<td></td>
<td>Activity</td>
</tr>
</tbody>
</table>

**Business Partner End of Purpose (EoP) Check in Human Resources**

Human Resources provides an (EoP) check to determine whether employee business partner is still relevant for business activities in the application or can be blocked.

<table>
<thead>
<tr>
<th>Application Name</th>
<th>Application Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUCP</td>
<td>Central Business Partner: Employee</td>
</tr>
</tbody>
</table>

i Note

For more information, refer [2142308](#).
7.16.4.2 Design Constraints

Workplace Address Data

If the infotype 105, system User Name (SY-Unname) 0001 is maintained for the employee and workplace address is synchronized then User will be converted to type 04 (Identity with Workplace Address).

In case User assignment is removed (infotype 105, subtype 0001 is removed for the employee) then after the employee synchronization report execution, then user need to be unassigned from the business partner by running the report RSUID_REMOVE_FALSE_BP_ASGN. Refer note 2568251 for more information.

In case User is converted to 02 or 04 - IDADTYPE then Workplace address or address section will not be editable in User Administration transaction like SU01.

Support of Other employment scenarios in Employee-Business Partner Synchronization

The synchronization is able to handle employees with single employment and single vendor assignment only, other scenarios are not supported (like Concurrent Employment, Global Employment, Country Transfer).

Implement note 2535438 to synchronize Multiple Employment (Concurrent Employment, Global Employment, Country Transfer) scenarios. Followed by note 2517507.

7.16.5 FAQ

For more information about the FAQs, refer to the SAP Note 2409229.

7.16.6 Related Notes

- 2265093 - S4TWL - Business Partner Approach
- 2570961 - Simplification item S4TWL - Business User Management
- 2383837 - S4TWL - SAP Learning Solution not available in Compatibility Mode
- 2340095 - S4TWL - Conversion of Employees to Business Partners
- 2273108 - S4TWL - General HCM Approach within SAP S/4HANA
- 2383888 - S4TWL - SAP E-Recruiting not available in Compatibility Mode
- 2383879 - S4TWL - Java-based ESS and MSS not available in Compatibility Mode
- 2393462 - All changes in 1610
- 2241838 - Limitations to PRAA transaction in S/4HANA
- 2399801 - Workplace Address synchronization corrections
7.17 Follow-Up Activities for SAP S/4HANA for Extended Procurement

7.17.1 Integration in SAP S/4HANA

This section describes the integration of SAP S/4HANA for extended procurement.

SAP S/4HANA for extended procurement enables you to manage the procurement processes of back-end systems from a single-source system. In SAP S/4HANA for extended procurement, you have the option of integrating the SAP S/4HANA hub system with one or more SAP S/4HANA or SAP ERP systems as back-end systems.

The SAP S/4HANA hub system can be operated centrally by the company headquarters, whereas the respective SAP S/4HANA back-end systems are operated by the subsidiaries. Using this approach, you can simplify certain aspects of your procurement processes. For example, employees from different subsidiaries raise requests to procure materials by creating self-service purchase requisitions (PR) in the hub system of the company headquarters. When employees create purchase requisitions, they are only able to select materials from the subsidiary that they belong to. They are also provided with information about available sources of supply, for example, contracts and purchasing info records, for the selected material. After an employee, has completed and saved the PR, it goes to the approval process. After the approval process is completed, the PR is replicated to the respective back-end system of the subsidiary that the employee belongs to. After successful replication, a purchase order is created automatically to procure the material, and the number of the purchase order is updated back to the self-service PR.

If you want to use the SAP S/4HANA system that you have installed as one of the back-end systems for SAP S/4HANA for extended procurement, then the following information is relevant to you.

The integration of the SAP S/4HANA hub system with SAP S/4HANA as the back-end system is supported in on-premise and cloud integration scenarios. If you want to integrate the SAP S/4HANA hub system with the SAP S/4HANA back-end system, you must install the HUBS4IC add-on.

\[\textbf{i} \quad \text{Note}\]
You only need to install this add-on if your SAP S/4HANA back-end system is an on-premise system.

7.17.2 Integration Scenarios

The integration scenarios using SAP S/4HANA as a back-end system in SAP S/4HANA for extended procurement are described.

This document is only relevant if you are using SAP S/4HANA as a back-end system in SAP S/4HANA for extended procurement. If you consider your current SAP S/4HANA installation to be the back-end system, continue reading.

You can use your current integration based on SAP S/4HANA to implement SAP S/4HANA for extended procurement. If you are an SAP S/4HANA customer also using SAP ERP, you can continue to use SAP ERP.
Prerequisites

To open the connectivity of the hub system and the back-end systems, an integration add-on must be installed for each of the back-end systems. The add-ons for SAP ERP and SAP S/4HANA back-end system are as follows:

- **HUBS4IC**
  This add-on is used to integrate the SAP S/4HANA hub with SAP S/4HANA back-end systems and is available for support pack SP00.
- **HUBERPI**
  This add-on is used to integrate the SAP S/4HANA hub with SAP ERP and is available for support packs SP00, SP01, and SP02.

Integration Scenarios

The following integration scenarios are available:

**On Premise (OP)**

This scenario is relevant if you want to connect one or more SAP ERP or SAP S/4HANA back-end systems to the SAP S/4HANA hub system to carry out procurement processes in an OP environment.

*Note*

Depending on the support pack that you install, you get different functionalities. For example, if you install SP02 of HUBERPI, it includes the functionality for central contracts and central requisitioning but if you install SP00, you get the functionality for central requisitioning only.

For more information, see release information note [2491065](#).
Hybrid - SAP S/4HANA Cloud and SAP S/4HANA back-end (OP)

This scenario is relevant if you want to address your strategic procurement needs in the cloud and at the same time continue to maintain OP investments for operational procurement.

Deployment Option: Hybrid - SAP S/4HANA Cloud and SAP S/4HANA (OP)

More Information

For more information, see release information note 2573672.

7.18 Follow-Up Activities for the SAP S/4HANA Financial Closing Cockpit

7.18.1 Setting Up the BI Content

This section includes information on how to set up the Business Intelligence (BI) content for the SAP S/4HANA Financial Closing cockpit. You can find the BI content at the following locations:

- Other objects: On the SAP Help Portal, search for BI Content. Open the latest version of the BI content (for example, BI Content 7.57). Under Application Help, open SAP Library. There, go to chapter SAP ERP Central Component > Financials > SAP Financials Closing cockpit.
Prerequisites

- The SAP ERP Central Component (ECC) system where the SAP S/4HANA is installed is connected as a source system. To achieve this, complete the following steps:
  1. Run transaction RSA1 on the SAP Business Warehouse (BW) system.
  2. Click Source Systems on the Modeling tab.
  3. Right-click a folder and choose Create from the context menu to add a new system.
- BI Content 7.57 for SAP NetWeaver 7.5 is installed on the BW system.

Procedure

Configuring the BW System

Installing the BI Content

To install the BI content for the SAP S/4HANA Financial Closing cockpit, complete the following steps:

1. Replicate the DataSources for the SAP S/4HANA Financial Closing cockpit from the source system to the BW system:
   1. Run transaction RSA1.
   2. Click DataSources on the Modeling tab.
   3. Choose the Replicate Tree Metadata pushbutton to get the list of the DataSources from the source system. If the list does not appear, run transaction RSA9 on the source system to enable the hierarchy.
   4. Right-click Financial Closing Cockpit and choose Replicate Metadata from the context menu. Choose As a DataSource when prompted for non-hierarchy DataSources and As a 3.x DataSource when prompted for hierarchy DataSources.
2. Activate the DataSources:
   1. Run transaction RSA1.
   2. Click DataSources on the Modeling tab.
   3. Double-click each DataSource under Financial Closing Cockpit and activate it. After a DataSource is activated, an entry Data Flow Upwards appears under it.

   Note

   Before you activate hierarchy DataSources, for both segment Hierarchy Header and Hierarchy Node, you also need to copy the relevant InfoObjects from the table on the left to the one on the right on the Transfer Rules tab.

3. Install the BI content for the SAP S/4HANA Financial Closing cockpit:
   1. Run transaction RSA1.
   2. Click Object Types on the BI Content tab.
   3. Choose the Source System Assignment pushbutton and then select the source system in the dialog box that appears.
   4. Expand Query Elements and then double-click Select Objects.
   5. Select the queries for the Financial Closing cockpit. You find all the queries for the Financial Closing cockpit by entering 0FCC and then choosing the Find pushbutton.
6. For each query, choose Grouping In Dataflow Before and Afterwards, and then choose Install.

Extracting Data from the BI Content

To extract data from the BI content you have installed, complete the following steps:

1. Create InfoPackage for each DataSource:
   1. Run transaction RSA1.
   2. Click InfoProvider on the Modeling tab.
   4. Right-click each Datasource and choose Create InfoPackage from the context menu.

2. Define data selection for each InfoPackage to extract data:
   1. Run transaction RSA1.
   2. Click on the Modeling tab.
   3. Double-click each DataSource.
   4. On the Data Selection tab, enter the parameters for data extraction.

3. Extract data:
   1. Run transaction RSA1.
   2. Click InfoProvider on the Modeling tab.
   3. Double-click each DataSource.
   4. On the Schedule tab, click Start to extract data.

4. Run Data Transfer Processes:
   1. Run transaction RSA1.
   2. Click InfoProvider on the Modeling tab.
   3. Double-click each Data Transfer Process.
   4. On the Execute tab, click Execute.

5. (Optional) Set up Process Chains for data extraction.

Configuring the ECC System (for Viewing the Reports via NWBC)

Configuring Roles

To configure roles, complete the following steps:

1. Run transaction PFCG.
2. Enter role SAP_FCC_MENU and choose the Change pushbutton.
3. On the User tab, add IDs for the users who shall view the reports via SAP NetWeaver Business Client (NWBC).

Changing the System Alias

To change the system alias, complete the following steps:

1. Run transaction LPD_CUST.
2. Double-click the line that specifies FCC as the role and FCC_REP as the instance.
3. Double-click each query and change the system alias to the one connected to the BW system.
7.19 Follow-Up Activities for Agricultural Contract Management

Once the installation is complete, you need to perform the following activities for Agricultural Contract Management (ACM):

Delivery Customizing

You must copy the delivery customizing for ACM from client 000 to your system-relevant clients. To compare the customizing content contained in these clients, you can execute the transaction Customizing Cross-System Viewer (SCU0). For ACM, the following application components are relevant:

- LO-AGR-LDC
- LO-AGR-APP
- LO-AGR-STL
- LO-AGR-CC

Important SAP Notes

You can copy missing delivery customizing in your relevant client, by activating all the switch BC sets associated with the ACM switch.

For more information, refer to SAP Note 1909425 (SFW- Activation error in Dictionary: clear up the inconsistencies).

7.19.1 Integration with Oil & Gas and Commodity Management

Agricultural Contract Management (ACM) is delivered as part of Oil & Gas (IS-OIL) and is integrated with Commodity Management (CM). This integration enables the user to use various CM functions for the commodities processed based on the ACM scenarios.

Integration

To activate the ACM business function (/ACCGO/BE_ECC), either the IS-OIL or the I-TSW business functions must be activated as a prerequisite:

- IS-OIL business functions:
  - BUSINESS_FUNCTION_BASIS_COM
• COMMODITY_MGMT_&_BULK_LOGISTIC
• LOG_COMMODITY_TRANSPORT_MGMT_8

● I-TSW business functions:
  ○ LOG_TSW_ECC

The integration with CM has been achieved through incorporation of various CM switches in the ACM business function `/ACCGO/BF_ECC`.

### 7.20 Troubleshooting

**Unable to Create New Clients**

If you are unable to create new clients in transaction SCC4 or SM30 (table T000) because the New Entries button is missing, see SAP Note [2140167](https://support.sap.com/).
Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.

About the icons:

- Links with the icon 🌐: You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your agreements with SAP) to this:
  - The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
  - SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any damages caused by the use of such content unless damages have been caused by SAP’s gross negligence or willful misconduct.

- Links with the icon 👤: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your feedback (e.g., in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of example code unless damages have been caused by SAP’s gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.